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Discover the 
power of 
Blender
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NikolaNovakonmodelling in BlenderPage34

  I’ve found edge-by-edge 
modelling techniques fi t best, so I
modelled with a circle mesh  



I’m in awe of what the Blender

community has accomplished

since seeing the trailer for Cosmos

Laundromat back in May, and so it

felt right to take this opportunity

to really take a look at just what

Blender can do. After all, it’s being

used by the community to make

the pilot chapter of what will

eventually be the world’s first open source animation

feature film, and so my question is this: if you can make

a movie with it, what else can you do?

You might be skeptical due to the fact that it’s free,

feeling that it won’t stand up to Maya, 3ds Max,

ZBrush and the like – a fair opinion and one that I don’t

begrudge, but you need only to head to our feature on

p30 to find out just how special and versatile it is.

We’ve also had Blender genius Reynante Martinez put

together two incredible tutorials for you (p40 and p74)

and virtuoso Kevin Hays explains how to create an

awesome Blender crystal effect on p72.

We’ve also taken a fascinating look at how

Wargaming is re-creating history in World Of

Warships by using original schematics as reference

material, ZBrush mech tips on p22, a sculpted beast on

p56, part two of Jahirul Amin’s Maya rigging

masterclass on p64 and Matthias Develtere from

MachineGames builds a tank in MODO on p68.
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This issue’s team of pro artists…

REYNANTE MARTINEZ
reynantemartinez.com

It’s likely that you’ll have seen some of the

incredible work that Reynante has done in

Blender and Cycles, and we’re really 

pleased to have him on board this issue 

for two incredible tutorials. 

3DArtist username reynantem

JAHIRUL AMIN
jahirulamin.com

It’s great to have Jahirul in the magazine 

as usual and even better to have him 

explain his Set Driven Keys wizardry. 

Rigging can be complex, but learning 

from Jahirul is your best bet at cracking it.

3DArtist username n/a

SETH NASH
sethnash.com

Seth has returned this month to cast a 

critical eye over Mixamo 2.0, the online 

animation and rigging application that 

takes the pain out of moving characters. 

You’ll fi nd his review on p82.

3DArtist username n/a

MARIANO TAZZIOLI
mtazzioli96.cgsociety.org

Still as talented and as absurdly young as 

before, Mariano returns for another mech

masterclass in ZBrush, taking you from 

concept to fi nal render. His tutorial begins

over on p48. 

3DArtist username n/a

MATTHIAS DEVELTERE
develterematthias.wordpress.com

Matthias works as a 3D artist at 

MachineGames, the studio responsible 

for the superb Wolfenstein games The 
New Order and The Old Blood. Check out

his tank tutorial on p68. 

3DArtist username DevMatt

LARISSA MORI
3dartistonline.com

Larissa is leaving us this month after 

being the voice of 3D Artist for over two 

years – we’re sad to see her go. Soak up 

her enthusiasm and knowledge one last 

time in her Blender feature on p30. 

3DArtist username Larissa_3D Artist

JAMES SURET
zerojs.cgsociety.org

Another return from another phenomenal 

artist on p56 as James reveals his expert 

sculpting workfl ow for creating a 

terrifying beast in ZBrush, revealing how 

to model, texture and render his creation. 

3DArtist username zerojs

KEVIN HAYS
jeepster.cgsociety.org

We spotted Kevin’s crystal turtle a while 

back after it caused quite a stir online and 

desperately wanted to fi nd out how he 

created such an incredible crystal eff ect 

using Blender. He reveals all on p72. 

3DArtist username khays

ORESTIS BASTOUNIS
twitter.com/mrbastounis

Our favourite tech genius has taken a look 

at the latest 3D/CAD workstation from 

Chillblast this month, putting it through 

its paces in ways we don’t understand. 

His review is on p78.

3DArtist username n/a
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12 Amazing things 
youcandoinBlender

 News, reviews 
& features
 10  The Gallery

A hand-picked collection of incredible 
artwork to inspire you

 22  Blueprint for Success
Discover how the team at Wargaming, the  
maker of World Of Tanks, is re-creating 
historical vessels from genuine 
schematics in World Of Warships

 28  Technique Focus War 
Gabriele Maiocco explains his approach to 
fantasy sculpting in ZBrush, why he 
analysed shapes and proportions, and 
chose to not use custom Alphas

 30  12 Amazing Things you can 
do in Blender
From simulation to photorealism, 
videogames to movies, we talk to some of 
the best artists working in Blender today 
about why the free tool is so good

 54  Technique Focus Baneling 
Tamas Gyerman reveals how he creates 
incredible sci-fi  designs inspired by the 
videogame StarCraft

 78  Review: Chillblast Fusion Projection 3
Orestis takes a look at the latest 3D-ready 
off ering from the reputable south coast 
outfi t and off ers his verdict

 80  Review: Wacom Cintiq 27QHD
Our verdict on the latest high-quality 
graphics tablet technology from Wacom. 
Get your desk space ready because it’s 
absolutely enormous

 82  Review: Mixamo 2.0
Fresh from being bought by Adobe, 
Mixamo is analysed by Seth Nash, who 
delves into the simple functionality of the 
online character animation tool

 84  Subscribe Today!
Save money and never miss an issue by 
snapping up a subscription

Render still life 
with Blender 

and Cycles

Design & build a 
detailed tank

JonathanWilliamsonon mesh modelling in Blender Page 32

SAVE 40%
SUBSCRIBE TODAY

Turn to
page 84 
for details

 Blender lets you work very quickly based on quick hotkey actions rather 
than requiring you to fi rst specify a tool and then perform the action  

30

40 7019
PAGES 

OF BLENDER 
PROJECTS
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JamesSureton sculpting the first details
Page 58

The Pipeline
 40  Step by step: Render still life 

with Blender and Cycles
Reynante Martinez creates 
unbelievable Blender imagery

 48  Step by step: Construct a 
futuristic mech
Teenager Mariano Tazzioli explains 
his cyborg building workfl ow

 56  Step by step: Awaken a beast 
with ZBrush
James Suret returns with another 
terrifying beast for you to recreate

 64  Pipeline techniques: Use Set 
Driven Keys to rig a hand
Join Jahirul Amin for part two of his 
Maya rigging masterclass

 68  Pipeline techniques: Design & 
build a detailed tank
MachineGames’ Matthias 
Develtere explores poly counts

 72  Pipeline techniques: Model and 
texture crystals in Blender
Create a stunning eff ect with the 
help of Kevin Hays

 74  Pipeline techniques: Set up a 
lighting rig in Blender 
Another dose of Reynante 
Martinez’s considerable talents

The Hub
 88  Community news

We speak to the Humster3D 
Ancient Rome Challenge winners

 90 I ndustry news
Adobe buys Mixamo and Apple 
promises blistering render speeds

 92  Studio Access: Audiomotion
How the famous studio got horses 
involved in motion capture

 94  Readers’ gallery
The 3DArtistOnline.com
community art showcase

Construct a 
futuristic mech

Audiomotion Studios Model and texture crystals in Blender

Essential Blender video
tuition from Digital-Tutors
Premium CGAxis models
25 awesome textures
from 3DTotal
Exclusive Muscle Tools demo
Exclusive Gaffer trial

Turn topage96 for the complete
list of this issue’s freedownloads

The Dam_Standard brush is great for
carving lines and wrinkles  

fi lesilo.co.uk/3dartist

DOWNLOADFROM THE

Visit the 3D Artist online shop at

for back issues, books and merchandise

92

56

72

46
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Have an image you feel passionate about? Get your artwork featured in these pages

Create your gallery today at www.3dartistonline.com

Safouen is a self-taught artist, 
working as a lead 3D modeller 
for D-TEK STUDIO since 2011 

Safouen Laabidi
artstation.com/artist/safwen

Software ZBrush, 3ds Max, 
Substance Designer, 
Substance Painter, Photoshop, 
After Eff ects

Work in progress…

 I took most of the robot parts to 
Substance Designer and baked a 
curvature map, an AO map and a 
position map. From that I created a 
smart material, adding the scratches in 
a mask and generator combination  
Safouen Laabidi, Wrecktos robot concept, 2015
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Work in progress…

Sergio Filho
tincat.co.uk

Software Maya, mental ray, 
ZBrush, Photoshop

Sergio has over 20 years of 
illustration experience and a 
Cannes Lions award

 This image was 
commissioned by JWT agency in 
São Paulo and is part of a series 
of ads. The art director was 
Waldemar França. The other 
campaign images also depict 
dramatic scenes of famous plays, 
like Romeo and Juliet
Sergio Filho, Cyrano de Bergerac, the play, 2015
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 As a hard surface guy, this scene was a 
huge challenge as it was mostly made of 
organic elements. I had to learn how to deal 
with VRayProxy for the grass, plants and 
stones, and Particle Flow for the leaves 
Jose Klaus González Rohbrandt, BONSAI, 2015

Work in progress…

Jose Klaus González 
Rohbrandt
joseklaus.cgsociety.org

Software 3ds Max, V-Ray, 
RealFlow, ZBrush, Photoshop

3DArtistOnline username: 
joseklaus
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 This was inspired by the song 
Mambacore. I wanted to illustrate two 
aspects: the sounds of the song based 
on African instruments and rhythms, 
and the electronic music scene 
Fer Aguilera Reyes, Mambacore, 2015

Work in progress…

Fer Aguilera Reyes
pigmachine.cgsociety.org

Software Maya, ZBrush, 
Arnold, Photoshop

3DArtistOnline username: 
pigmachine
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 With this piece I wanted 
a new workfl ow for quick 

robots. The plates were 
sculpted from DynaMesh 

spheres and I used 
diff erent IMM brushes for 

the mechanical parts
Jörn Zimmermann, Robot 

Concept KeyShot Render, 2015

Jörn is a UI Designer currently 
working at Ubisoft Blue Byte’s 
Mainz Studio

Jörn Zimmermann
artstation.com/artist/joern

Software ZBrush, KeyShot, 
Photoshop

Work in progress…
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In depth

Patrick is a 3D artist from 
Belgium with a passion for 
character design

Patrick Evrardt
patrickevrard.com

Software ZBrush, Maya, 
Photoshop, KeyShot, V-Ray

Work in progress…

 This image was created for 
the Trojan Horse Was a Unicorn 
festival challenge. This year’s 
theme was tribes
Patrick Evrard, THU 2015 Challenge Entry, 2015
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CREATING ART FOR A COMPETITION
TOP I tried to visualise the challenge itself, with all the different challengers working 
in their own style and by doing so creating their own kind of tribe. All the time being 
watched by more anonymous online followers. I think I worked on this image 
between 170/255 hours and it was a ton of fun.

MY INSPIRATION
TOP When I think of tribes I 
think of being proud. This was 
my starting point. I didn’t want it 
to be too serious so I thought I 
would go for a cartoon-y style. A 
silly face alone wouldn’t do the 
trick though so I went online 
looking for inspiration on the 
THU page (trojan-unicorn.com), 
which I found in a comment of a 
photo. The photo showed a few 
speakers at the previous THU 
event just sitting at a table in the 
sun. The comment was that they 
were all masters in different skills 
and styles. This inspired me 
because this is what I also like 
about challenges: people with 
different skills and styles coming 
together to join a challenge. This 
is what I wanted to represent in 
this picture.

CHARACTER DESIGN
RIGHT I just finished Breaking 
Bad and had seen a lot of 
likeness studies of Walter so I 
thought it would be funny to have 
him cooking on the back of the 
horse. The two girls on the 
dragon are based a bit on my 
daughters, one is Lux (light) and 
has a glowing crown and 
fluorescent light. The other is 
Lotus based on the flower, she 
has petals of a lotus flower as 
hair.  There is a sci-fi shooter on 
the back of the horse but I didn’t 
want him too aggressive-looking 
so I made him shoot soap 
bubbles in the shapes of hearts.

  

 With creating character 
silhouettes: I’ll sculpt until I‘m happy 
with the base form. I might use 
Polypaint to get inspired, which I can 
apply with Spot Light
Patrick Evrard, THU 2015 Challenge Entry, 2015
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Wego behind the scenes atWargaming, creator of
WorldOfWarships, and discover a 3D production

pipeline like no other

W
hether you’re making videogames,

films, commercials, shorts or

otherwise, the process generally starts

the same way – with a basic concept. This can

take many forms, from full 3D concept work to

matte paintings of landscapes and, in a lot of

cases, hand-drawn reference materials. At

Wargaming, the studio that has achieved

monumental success with games like World Of

Tanks and World Of Warplanes, they do things a

little differently.

Formed inMinsk, Belarus, in 1998,Wargaming has

grown exponentially since the release ofworldwide

phenomenonWorldOf Tanks, whichwas first released

in 2010. Due to itsmassive popularity andwide appeal,

Wargaming set out to release follow-ups to its flagship

IP, and so the company looked to othermethods of

warfare for inspiration.

A high level of success and user uptake forWorldOf

Tanks enabled the studio tomove into new locations

around theworld, and at present it has offices in

locations around Europe, America, Asia andmore.We

were invited to the company’s development studio in

Saint Petersburg, Russia, to learn all about its unyielding

approach to historical accuracy that extends far below

the game’s polished surface and right down to the

modelling and texturing of authentic sea vessels for its

latest title,WorldOfWarships.

THE

FOR

SUCCESS
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Wargaming's asset library is impressive, with 
over 2,000 objects that can be used 

Y
ou’ll notice that a large proportion of the 

expert tutorials that we commission for 3D 

Artist start in exactly the same place – gather 

references. At Wargaming, this is a crucial part of 

the pipeline and has resulted in the team of artists in 

St Petersburg pushing the boundaries of historically 

accurate models in videogames. By utilising a 

combination of photographic references and, 

amazingly, original blueprints and schematics from 

the early to mid-20th Century, the Wargaming team 

devotes a huge amount of time to research in order 

to fulfil its fidelity remit, as senior technical artist 

Alexander Zotikov explains.

“I would say that we are researching when we 

are modelling. That’s why just one modeller 

creates the model and then [does] the texturing, 

because the period when they model is also the 

period when they understand what happens on 

that [particular] ship. And then they know that, 

for example, ‘this thing is for something’ and 

‘there you need to texture something’, like some 

rust maybe. Because, if I gave you just the 3D 

model and said ‘can you texture it for me?’ it will 

take a lot of time to understand what happened.

“It’s a good thing to learn [as much as you can] 

about the ship or object that you’re making. I think 

the modeller has to learn what they’re doing. So 

before I start modelling, I try to read about the 

ship and what it has done in the past, historically.”

Artists work on individual ships by themselves, 

taking control of both modelling and texturing to 

an astonishing level of comparison with the real 

thing. It’s a process that takes many months and 

one that requires the artist to be completely au 

fait with their allocated ship, from the overall hull 

shape right down to the nitty-gritty such as chain 

placement and ascertaining where you’d fi nd 

examples of rusting on a real boat. This is best 

achieved by thoroughly researching the ship.

“On the one hand [research] can help you to 

create some construction things,” continues 

Zotikov, “like you understand that this ship is not 

symmetrical and you know that on the right side it 

will have some curves – sometimes you cannot 

understand these things from photos or 

blueprints. On the other hand, it’s diffi  cult to 

model and texture one model for several months 

– you need to have some stimulus. It should be 

like it’s a part of you!”

Art director Anton Oparin, however, warns us 

of the dangers of going overboard with photo 

references, as it can have a detrimental eff ect on 

your personal workfl ow. “You can collect a lot of 

information and exact references and try to 

[make] accurate, realistic models. In the case of 

landscape models we collect a lot of references to 

make realistic environments.

“A large amount of references can [result in] 

bad work because it doesn’t make you 

concentrate on specifi c objects. We use the main 

reference for the hull shape, for example, and 

smaller references for texture and for parts. Before 

our artists can start working they combine these 

references and then they will make the fi rst 

prototype to make sure that they have made 

things the right way.”

I
t’s a thorough and, to the untrained eye, 

unforgiving process. Imagine being asked to 

draw one of these ships 100 per cent accurately, 

let alone having to model and texture these ships 

so that neither an eagle-eyed player nor pedantic 

historian would be able to fi nd fault with your 

rendering eff orts. Luckily for the Wargaming 

team, its established production pipeline comes 

complete with its own neat little shortcuts to help 

lighten the load.

Key to this interesting pipeline is Wargaming’s 

object manager, which is essentially a vast library 

of diff erent assets that modellers can pillage to 

speed up their own personal workfl ow when 

building a ship for the game, as Zotikov explains. 

“There are over 2,000 objects such as fi re poles 

and stairwells. We also have planes and all of the 

diff erent kinds of guns, like anti-aircraft, main guns

for battleships and cruisers, secondary guns and 

torpedo tubes. Much the same, we have [a library

of] locations and buildings.”

Of these prebuilt items, a proportion of them 

are country-specifi c, such as fl ags and diff erent 

variations of lifeboats that are specifi c to the 

diff erent fi ghting nations depicted in the game. All

of these prebuilt assets give Wargaming’s 3D 

THE BLUEPRINT FOR SUCCESS
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There is a 300,000 poly restriction, but the 
details per ship to make up the poly count diff ers

War machine
Wargaming has fi nely honed its 
craft with two games prior to 
World Of Warships, both of 
which set their sights on fi delity

World Of Tanks
First released in 2010, World Of Tanks 

helped to popularise the sometimes-

derided free-to-play market with its 

undeniably addictive brand of team-based 

warfare. Sat in a tank of your choice, you 

and your comrades would do battle with 

another team across vast and varied 

environments. It was here that Wargaming 

began to fully harness its talent for 

historical re-creation, and even fi ve years 

ago the vehicle models were second to 

none in terms of their authenticity, with 

only games such as Company Of Heroes 

really competing with Wargaming’s 

understanding of modern military history.

World Of Warplanes
Wargaming took to the skies in 2013 with 

this follow-up to World Of Tanks, off ering 

you the opportunity to compete in over

erent aircraft models, again all built

zying level of authenticity. The aim

ame was, once again, team

atch, but this time the focus was

ng air superiority by downing

fighters and multirole aircraft. The

of modelling and texturing is plain

s in World Of Tanks – even the

inute of details are included, and

ironments that you dive and roll

e as expansive as they are stunning.

artists the scope to spend an awful lot of time 

getting the fundamentals right, such as hull 

design, bridge design and scale across the board. 

An interesting example that we were shown is 

the chain tool that Wargaming’s 3D artists have 

at their disposal, allowing them to place multiple 

instances of the same chain geometry on the 

particular ship that they’re building and then hop 

into the rig and change the chain’s position and 

style on the fl y. Zotikov explains how the scripting

process works.

“This is MEL script but most of our tools are 

now done in Python. It’s useful because you can 

use external libraries, and also for this tool, each 

chain has its own mapping. We have a Smart 

Object in Photoshop that you put on your ship 

and then you just push the button and the chain is

magically mapped in other textures, so you don’t 

need to place by hand. So we don’t need to have a

lot of objects on our ship, so we have one object 

with one texture for optimisation. Although, 

sometimes we have two texture sets, especially 

on a big ship.”

These helping hands are a neat augmentation 

of the development team’s core focus on accurate

models and texture maps, and they allow the 

team to cope with such huge demands, both in 

terms of meeting the brief for individual ships 

and the fact that the game is set to feature an 

enormous amount of diff erent playable vehicles, 

as Zotikov tells us.

“We have various types of ships. In our game 

we have destroyers, the largest [of which] is 

about 100m, we also have cruisers that are 

about 150m, but they can diff er a lot, and 

sometimes they have aeroplanes. There are light 

cruisers and heavy cruisers, which are as big as 

battleships. We have battleships that have big 

guns and [a lot of] power, and they diff er a lot 

[in size]. Then we have carriers…”

Z
otikov goes on to show us a model on his 

screen that appears to be cracked in 

several places. He explains that “when 

you die – the ship can separate into two parts, 

so we have these cracks that we also have to 

model. We model three cuts so it can [separate] 

in diff erent ways. We also have to model the 

internals, and that’s why we need blueprints to 

make sure that [a ship] had [for example] four or 

fi ve decks.

“We cut the outer shell by hand and inside it’s 

all a reference model. We have these decks as 

reference so we can put them inside your ship. 

We also have some references for
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Research is essential for Wargaming, but the right 
balance of references is even more important



often a concern when building models before

placing them in-engine. Zotikov is in agreement 

that it can be a concern, but makes it clear that 

the team needs to be adaptable in order to be

able to deal with the different demands that each 

individual ship model presents.

“We have a 300,000-poly restriction,” he

reveals, “but it always differs [depending on] time 

modelling. It can be a little ship but with a lot of 

details that we need in the game, so we need to 

model all of them. But sometimes we have a big 

ship with not a lot of details, so it really differs.”

Once the model is finally finished, the team 

foregoes churning out a render to check its

quality, instead opting to export the model and, 

separately, its texture maps, from Maya and into 

the BigWorld MMO game engine, where it is all 

pieced together. This process enables the artists 

to see their models with proper illumination as a 

preview in the game engine, and ensures that

they’re able to spot any problems before

submitting the final product.

“We have statistics on textures and polygons 

and also it’s here where we assemble our models

multiplayer online games so they need to run fast! 

Optimisation is key. We have a lot of ships and 

they should be similar to each other – one 

shouldn’t be more polygonal than another.”

Zotikov agrees with us when we ask whether 

it’s a bit of a shame having to slightly reduce poly 

count and, subsequently, visual quality in order to 

ensure that everything is of a comparable level 

and can be used in-engine, however, in game 

development this is essential. What was overtly 

clear to us was the amount of technical skill, 

passion for history and artistic fl air that goes into 

ch and every model that Wargaming makes in 

int Petersburg, and despite the need for 

storical accuracy, the artists still approach the 

odelling and texturing processes as art. “But 

etimes,” reveals Zotikov, “you have a lot of 

otos and a lot of blueprints, and you can’t just 

t something where you want! There are two 

des to it.”

Judging by the success of its forebears, it looks 

ely that World Of Warships will be immensely 

pular when it launches in the near future. 

espite spending a long time in development, 

tikov and his team are far from fi nished yet. 

ow we are really focused on our game and we 

ve some time for revisions. Our department 

eds to export a lot of ships!”

World Of Warships is currently being 
veloped by Wargaming. For more information 

ease visit wargaming.net.

Tools of the trade
Art director Anton Oparin
explains Wargaming’s artistic
pipeline and primary 3D toolset

How is the artistic 

pipeline diff erent 

starting a new game 

compared to when you 

made World Of Tanks?

I guess our pipeline is quite diff erent now. 

We started with a pipeline [that was] 

almost exactly like World Of Tanks but 

after some time we refi ned it for our 

needs. We refi ned all the models, the 

shaders, editors and some tools and now 

we have a diff erent pipeline with diff erent 

technologies. Of course we use the same 

basic technologies because we are using 

the same engine but [individual] parts are 

quite diff erent.

Has the same software always been 

used throughout?

Maya is our main 3D program. For some 

tasks we use 3ds Max and Houdini for 

special tasks, but the main one [that we 

use] is still Maya.

Is there any reason that Maya is the main 

program used?

Maybe because most artists are more 

familiar with it and Maya is good for game 

development. Of course Max is the same 

but we’ve chosen Maya!

Will Autodesk going subscription-only 

change a lot for you?

I guess we will use the subscription licence 

– we [already] use some subscription 

licences for some technical tasks The use 

of subscription licences isn’t a problem.
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Each ship is modelled and textured by a single artist, 
who will learn everything they can about their ship
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From sculpting, compositing and game creation to a full feature film, you
won't believewhat can be achieved for freewith the open source software

12AMAZINGTHINGSYOUCANDOIN

BLENDER
30



W
hen faced with an all-in-one 3D software solution that's also 

completely free to run, it's only natural to think that there 

must be some kind of catch. After all, the idea does sound too 

good to be true – and the common belief is that you get what you pay 

for. Assuming that because Blender is free it must not be a truly 

professional tool, however, is probably one of the greatest 

misconceptions in the industry.

“To be completely honest, the main draw for me was that it didn't need to be 

installed. You just download it, unzip it and run it,“ begins visual eff ects artist 

Sean Kennedy, who fi rst began using Blender throughout his time at Rhythm & 

Hues. “Sometimes for my shots, I would want small elements to composite in, 

like dust hits or background birds. At a large facility like R&H, this was a huge 

process. Everything would have to go through modelling, rigging, animation, 

texturing, get approved by at least two or three supervisors, and then fi nally get 

sent to me a week after I requested it. Blender intrigued me because I could 

download it and just have a program on my desktop that would let me make all 

these little elements.“

Kennedy was a lead compositor and would regularly create elements in 

Blender for the entire team. He even taught Blender to co-workers in after- 

hours classes. “People on movies I wasn't even working on would ask me for the 

background bird fi lesets I had created. Some of the movies I used Blender on 

were Big Miracle, RIPD, Percy Jackson: Sea Of Monsters, and one very small 

contribution to Life Of Pi… Features like Dynamic Paint really made jaws drop!“

Still actively developed by hundreds of artists, animators, VFX experts and 

hobbyists all around the world, Blender has changed the lives of more and more 

teams. Built-in features like a full compositor, video editor, 3D sculpting and 

animation tools along with a constant stream of new free add-ons have enabled 

artists access to what would otherwise be completely unattainable on a tight 

budget. The results have been incredible. 

With open projects like 'Tears Of Steel', 'Sintel' and now Agent 327 and 

Cosmos Laundromat, Blender has proved that even full fi lms can be created. 

More production-quality Cycles renders are being shown off  every day too. We 

spoke to some of the best Blender artists in the industry to discover more about 

just how much this surprising piece of software can do.

THE EXPERTS
Gleb Alexandrov 

creativeshrimp.com

Benoît Donat-Bouillud 

blenderartists.org/forum/showthread.

php?364800-Echec

Nikolaev Doutskinov 

krum-game.com

Manu Järvinen 
manujarvinen.com 

Sean Kennedy 

imdb.com/name/nm0448332 

José Luis Rozúa Lucena 

broadcastingcomics.com

Reynante Martinez 
reynantemartinez.com

Mason Menzies 

masonblenderrender.deviantart.com

David Norton 

multimochen.wix.com/portfolio

Nikola Novak 

cgtrader.com/koleos3d

Voloskov Denis Olegovich 

denvoloskov.blogspot.ru

Pierrick Picaut 
p2design.eu

Andrew Price 
blenderguru.com

Ton Roosendaal 
blender.org 

Lech Sokolowski 
chocofur.com 

Lucas Souza 

behance.net/lucasblender

Marcin Twarowski 
behance.net/tvaroog 

Brice Teluk 
bricetelukstudio.com

Kent Trammell 
cgcookie.com

Jonathan Williamson 

cgcookie.com
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01 Sculpt
a monster
With a host ofmodelling, sculpting, UV unwrapping

and retopology tools, andwith further innovations

inmesh editing being developed for 2015, Blender is

nownot only being frequently used for hard

surfaces, but for creating organicmeshes aswell.

“Blender sculpting tools turned out to be a

must-have formywork since it has dynto sculpting,“

reveals Pierrick Picaut, who is a Blender Foundation

certified trainer.

Dynto sculpting, or Dynamic Topology Sculpting,

is a sculptingmodewhere brushes usedwill

subdivide amesh as needed during the stroke,

enabling artists to create complex shapes out of the

simplest initial base. “So even if Blender can't handle

asmany vertices as ZBrush, it generates geometry

on the go and the brushes just react sowell,“ Picaut

continues. “That's one ofmy favourite tools.“

Another invaluable asset, he explains, was the help

of the Blender community.

Make mesh modelling more like sculpting by Jonathan Williamson

“The most exciting part of Blender's modelling toolset, in my opinion,

is one of its oldest features. This is the Select>Edit modelling

workflow as opposed to the more common Tool>Select>Edit

workflow. In essence this means that Blender lets you work very

quickly based on quick hotkey actions (such as extruding a selection

at anytime by simply pressing E) rather than requiring you to first specify a tool and

then perform the action.

“The real benefit to this is speed, as you can instantly activate different tools and

operations with a single click or hotkey. This workflowmakes mesh modelling behave

more like sculpting, in terms of raw speed and efficiency.“

Dynto sculpting with Pierrick Picaut

XXXXX XXXXXXXXX XXXXXXXXXX XXXXXXXX
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Creature Bust by Jonathan Williamson

The throne – Ember titan by Pierrick Picaut



02 Render stunning 
lighting

Gleb Alexandrov is already famous for the quality of his 

Blender work and tutorials on creativeshrimp.com, but his 

passion for the importance of lighting inspired him to go even 

further. With his Open Lighting Project, Alexandrov has been 

publishing chapters for a Blender/Cycles-based book of 

tutorials, developed specifically for anyone who has ever struggled with lighting. 

How did you first come up with the idea for the Open Lighting Project?
The idea behind my Open Lighting Project is simple. Lighting is much more 

than just the angle, the softness and the position of the lights. But what 

about the mood? And most importantly, what about aesthetics of lighting?

For example, lighting a highway at night is not simply a bunch of omnilights. If 

you really start looking, you will discover the weird world of blazing trails, infi nite 

motion and fireflies swarming. All of that makes your night-time highway 

lighting a complex aesthetical phenomenon, and it should be analysed as such.

What are the most important things you've learned from your work?
1. Think about the mood and emotion fi rst, technique second. Your viewer will 

see the overall mood and emotion of your work fi rst, so pay attention to it.

2. Don't use lighting just to showcase your fi nely crafted model. Lighting is a 

massive creative force by itself. If you use it only to showcase your model, you 

will miss the point.

3. Don't lock yourself in a box. Use knowledge from other fi elds, such as 

photography and film. Grab a camera and try creating overexposed high key 

lighting (you will love it!).

Exploring beyond three-point lighting 

by Reynante Martinez

“Lighting plays such a huge role in my work that I often 

tend to include it in the preproduction stages of my 

workflow. Before getting into the nitty-gritty of the 

modelling and texturing phases, I try to get an overall 

sense of depth and emotion in my scene by creating 

lights and shadows.

“To start off, I would usually utilise Blender's image-based lighting 

tools and use an HDR image as my primary light source, which will also 

dictate the time of the day that my scene is set in. If this works, I add 

complementary lamps (point lights, mesh lights and so on) to further 

accentuate the form of my objects; otherwise, I would use a Sun lamp to 

create my primary light. I usually don't stick with the three-point lighting 

method as is usually suggested, instead I add as few lights as possible or 

as many as needed, instead of constraining myself to a set of rules.“ 

Q&A with Gleb Alexandrov

Shaping the human head and face
with Kent Trammell

01 As an organic shape, the

head and face of a

character are excellent candidates

for when you're using dynamic

topology sculpting.

02 Because of this, I'd start with a simple

sphere and rough out the main structures,

moving with the Grab brush and pulling out new

geometry – like the neck – with Snake Hook. Then

it's just polishing eyes, nose, mouth and ears.

03 For a female with long hair, I would create a

base with the Skin Modifier, which is similar

to ZBrush's ZSpheres. It allows me to quickly

generate and shape new geometry that can easily

be styled into a hair base. From there it's polishing

the hairstyle with brushes like Flatten and Crease to

approximate a strand structure.
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The Lamp by Gleb Alexandrov

SSS Study by Kent Trammell



04 Model a futuristic supercar

Innovations inmesh editing keep happening in

manyways in the CG industry, and for Blender this

has been no different. Campbell Barton – the lead

coder of theMeshmodule on the Blender

development team – is officially planning to reserve

manymonths next year towork onmesh tools to

improve themeven further.

For cover artist Nikola Novak, hard-surface

modelling techniques andmesh toolswere crucial

in creating his latest futuristic supercar concept in

Blender. “Formost of the car's body design and 3D

modelling I needed just one day,“ Novak begins. “I

was very pleasedwith the design from rear and side

view. The biggest problem in designwaswith the

front view of the vehicle, which I spent about five

extra days changing and editing until I was pleased

with the final look.“

“I've found edge-by-edgemodelling techniques

fit best, so Imodelledwith a circlemesh shape.

Then I extruded the edges of the circle to cover the

edge ofmy image references,“ he continues. “When

Iwas pleasedwith the design I added a Subsurface

Modifier tomymodel to subdivide it. Thismakes

themodel look blobby, but after adding loopswith

Cmd/Ctrl+R, I created sharper edges, and it looked

just as I wanted. I alsomade changes by editing

vertices, edges and polygons on the hood and front

windows to get the right design proportions.“

05 3D print
like a pro

Now six years since he first started learning

Blender, animator, modeller and illustrator Manu

Järvinen has completely switched to open source

software to create his unique personal character

work. His favourite applications include Blender,

Krita and GIMP in Linux.

“I like to model almost every single detail of an

object by hand,“ says Järvinen, “so, it basically is

just meticulous and hard work. I also like to make a

lot of test renders in order to see where the picture

is going and to make sure the earlier decisions of

removing or adding something to the image were

wise choices. Often they were not.“

“Essentially, I don't like boring objects. So, I like

to caricaturise or add at least some kind of

personality, imperfections or wonkiness to pretty

much everything I make.“

03 Create unique
character art

It's an amazing feeling to be able to create

something in a computer and only hours

later, be able to hold it in your hands – so

it's no surprise that 3D printing has

become so popular amongst 3D artists

today.What is surprising is that Blender

also has the ability to easily prepare any

models for 3D printing – including error

checking themesh for few overhangs,

manifold geometry, correct thickness and

no intersecting faces – before exporting

them ready to print.

“From the beginningmy intentionwas to

print so Imodelledwith things like

thickness and construction inmind,“ tells

CGCookie's Kent Trammell. “Blender

comes packedwith a very helpful add-on

called '3D Printing Toolbox' that helps to

get technical details correct for printing. I

tested the centre of gravity by running a

rigid-body simulationwith Blender.

Surprisingly it stood up by itself well and

was later confirmed to do so as a physical

print. JonathanWilliamsonwas kind

enough to print formewith his Form 1+

and the final quality blewme away.My

newdream is tomodel and print custom

toys formy baby boywhen he grows up.“

Essential techniques with Nikola Novak

Concept work with Manu Järvinen 

Solid prints with Kent Trammell
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Blender3D supercar concept by Nikola Novak

Fishy Cat by Manu Järvinen Like a bull by Manu Järvinen 



Alien2 bySeanKennedy

“When you first approach simulations, it's both 

fun and intimidating. Simulations have been 

referred to as the 'dark arts of CG' for their 

frequently unpredictable behaviour and 

time-consuming tweaks.

 “Thankfully though, when you're starting 

out you're in good hands. Blender has a 

reputation for its many tutorials, so whether 

you want to make fire, water or just complete 

destruction; you'll find plenty of help.

“Smoke is probably the most fun and easiest 

simulation to pick up, so I'd recommend 

starting there. You can create a smoke 

simulation in Blender in just ten seconds: Open 

Blender, press Spacebar, type 'Quick Smoke', 

press Enter and then Opt/Alt+A to run it. The 

default cube is now on fire! 

“Like most young males, I've always been 

drawn to destruction and the chaos of the real 

world. My first short film ('The Ballad of the 

M4 Carbine') was a pretty shameless excuse 

to feature a bunch of automatic rifles firing. 

And in the six years since I created that, I've 

created explosions, flame-throwers, water 

splashes, sparks and a wrecking ball for equally

pointless reasons. I just love destroying things,

and Blender is my big open sandbox.“

Shattering glass with a bullet in Blender

“The plane of glass was first broken into

smaller pieces using the Cell Fracture add-on

(File>User Preferences>Addons), and then

simulated using the rigid body simulator to

make them come to life, reacting to gravity and

the impact of a heavy bullet shooting through

them. For more realism I then made each glass

piece emit a further 100 tiny shards of glass

using the particle simulator. And then for the

final touch, I used the smoke simulator to

create that ultrafine glass dust.

“All of this was done inside Blender. You can

watch the full tutorial on how to do it here: bit.

ly/BlenderGlassSmash.“

07 Simulate 
destruction  
by Andrew Price

From colour grading, lens distortions, vignettes and

film emulation, to rotoscoping and tracking, many

don't realise that Blender's built-in compositor can

do it all and more.

For VFX veteran Sean Kennedy, in fact, Blender is

now his favourite program to roto in. “I had been

learning Blender around the time they were creating

the tracking and rotoscoping toolsets for use on the

Blender Foundation's 'Tears of Steel', so I was

experimenting with the tools while they were

implementing them,“ he explains.“ They did a really

good job with tracking and rotoscoping. The

tracking is unbelievable. It's the fastest tracker I've

ever used. And the planar tracking is extremely

straightforward and easy to use. In regards to

rotoscoping, it's also very fast and simple especially

once you know the hotkeys.“

06 Composite a VFX scene

“Another thing I really like about it is that every

node's properties are right there on the node itself,“

Kennedy continues. “You don't have to have a

properties panel open to adjust settings. It really is

every bit as powerful as any other compositor.“

The single greatest advantage Blender gives for

Kennedy, however, is not within the software itself,

but with the people who develop it. “I experienced

this first hand at the Blender Conference a couple

years ago,“ he remembers. “I was chatting with

Sergey Sharybin, the lead developer of the

rotoscoping toolset. At this point they hadn't yet

included Bezier handles as a handle type, and were

thinking of not doing it. In about five minutes I talked

them into it, and ten minutes after that Sergey had a

working demo. In my entire career, I'd never seen

such a quick implementation of anything!“

GlassSmash–Fracture, RigidBodybyAndrewPrice

Rotoscoping with Sean Kennedy
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Want to develop excellent 
architectural visualisation scenes 
without spending money? These 
artists reveal how it's done

The challenge I ran into 

with 'Lounge Room' was 

with the exterior and 

interior – my computer 

simply couldn't handle it. I 

used a fantastic Blender feature called 

Render Layers toseparate the scene into 

multiple parts and combine them after. 

Mason Menzies

Always observe! Take a lot 

of reference images, and 

look at them closely! To get 

realism, try to reproduce 

what you see. Also, don't 

forget that every building, every room, has 

its own story, and you should put some life 

between those walls. Brice Teluk

Sometimes all you need to 

create a beautiful 

illumination is to use an 

HDRI image as a method of 

environment lighting. 

Works great, especially for the exteriors. 

Lech Sokolowski

Use Sun lamp and Area lamps! With Sun 

lamp you can quickly improve the general 

illumination appearance in your picture for a 

beautiful, directional ambient light. Also try 

to put an Area lamp into every window 

opening when illuminating an interior. It will 

speed up the noise-cleaning process and 

increase the shadow quality. 

Lech Sokolowski

09 Build stunning 
arch-vis

“I remember the first time I watched 'Tears of Steel'.

I just couldn't believe such an amazing piece of work

could bemade using an open source program,“

begins self-taught 3D artist, DavidNorton. “Android

was the first piece of work I sharedwith that

community, and I was very happy to receive a lot of

good feedback about it.“

Initially inspired bywatching I, Robot, Android

wasmade almost exclusively in Blender. “I initially

sculpted a simple female head using Blender's

sculpt tools and the dynamic topology feature. Then

Imanually retopologised themesh into quads,

08 Texture
sci-fi designs

keeping inmind that I wouldwant to cleanly

separate it into parts at a later stage,“ explains

Norton. “I UV unwrapped themesh and exported

the layout into Photoshopwhere I painted a simple

face texture. After themodellingwas complete, I

usedCycles to build thematerials. A lot of the

shadingwas done using dirtmaps, combinedwith a

grunge texture to achieve a 'slightly agedmetal'

look. Once the image had rendered I used Blender's

internal compositor to add some simple glare/glow

and contrast effects. After, I took the image back

into Photoshop for some quick colour correction.“

Android by
David Norton

Maps and materials with David Norton

Lounge Room by 
Mason Menzies
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11 Make a game

Incredibly, included within Blender is also a complete game

engine, making it possible for anyone to create a fully

featured 3D game with their characters and environments.

“I'm a heavy Unity user in my day job,“ begins game

developer Orlin Doutskinov, who has been working in the

games industry for over eight years. Using the Blender

Game Engine, he recently began to invest any free time

he had from working on triple-A titles into developing his

very own indie title, KRUM: a big third-person fantasy

hack-and-slash game.

“One thing that really stands out is the ability to craft or

edit your models, textures or write code directly into

Blender's environment. No need to switch software for

every particular job and cause your PC to crash,“

Doutskinov explains. “That is why the Blender Game Engine

is a hidden gem for small teams or individual game

developers, because everything you need for your project is

right there.“

Just last year, all of Doutskinov's hard work was rewarded

when KRUM was officially greenlit on Steam. “Honestly, I

cried tears of joy! [Getting greenlit is a] dream come true to

many indie game developers all over the world,“ he tells.

“KRUM is still in development, and I'll continue to develop it

in Blender until it is fully done. If I decide to make another

game, Blender will still be the first choice.“

Top tips for Blender realism by Voloskov Olegovich

01 Attention to nature, to all the things around you, and an 

understanding of how to represent those nuances is crucial.

02 A digital camera is a good friend to any CG artist. Learning to use

one will enable you to better understand composition, colour and

lighting, plus you can shoot your own textures!

10 Render extreme photorealism

03 It's very important to understand how different nodes interact with 

each other in Blender. Discover what a Fresnel is, and what real 

materials consist of.

04 Interactive preview is also an extremely useful Blender feature. You 

can see how your render will look like right in the viewport to be 

able to quickly check it for mistakes before going for the final image. It saves 

a lot of time.

05Remember that Blender's all-in-one interface gives you an extremely 

wide range of possibilities: you can model, sculpt your scene, paint 

textures, simulate elements like water, fire and smoke, and much more – 

and that's all in only one piece of software. Use this to your advantage.

Thanks to artists like Voloskov Olegovich and
José Lucena, we now know the boundaries of
CG photorealism can also be pushed as
Cycles gets more advanced

Handmade deco lights by Voloskov Olegovich Strawberry dessert by Voloskov Olegovich

KRUM by Orlin Doutskinov

Blender Game Engine with Orlin Doutskinov
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12 Animate a feature fi lm 

TonRoosendaal, chairman of The Blender Foundation

We can avoid compositing 
by rendering the whole scene 
in one pass

Blender will soon see two film releases to add to its 

portfolio. The first, code-named Project

Gooseberry, is 'Cosmos Laundromat' an animated 

short with a tentative pilot premier in August 2015. 

The project supports Blender Cloud: the ability to 

see every file the professionals made and share 

them for a subscription fee.

Agent 327 on the other hand is a commercial 

feature film made by Blender Foundation in

conjunction with Martin Lodewijk and Fu Works.

Ton Roosendaal, producer of 'Cosmos

Laundromat' and chairman of the Blender

Foundation reveals all about the two releases.

Can you tell us what you feel have been the main 
challenges and successes from the pilot so far?
We still want to wait and see how the audience 

responds, and what the reception is by important 

market players. We will make a bold statement with 

'Cosmos Laundromat'! It's currently impossible to 

predict what will happen with that.

At the beginning of the project it was said that 
70-80 people were expected to work for 18
months on Project Gooseberry. Has this changed?
M t f i t k th l ll

well we can roll out Blender Cloud. More 

subscribers means we can do things bigger and 

stay independent of market players.

Is it true that there was no compositing involved in 
the making of the trailer? How was this achieved? 
Yes we can avoid compositing by rendering the 

whole scene in one pass with depth of fi eld and 

motion blur in ray tracing. Obviously that comes at 

a price – the average render time (on a decent i7 

system) runs into six hours now.

Where did the idea of working on a fi lm for 
theatrical release like Agent 327 come from?
Making a feature fi lm stays the dream of any 

animator or fi lm-maker. With the 'Cosmos 

Laundromat' project on the rails, I want to keep 

moving on with our creative team to produce more 

work. We will do some shorts, but having another 

feature fi lm project to work on is inspiring, 

especially because we want do it as a 'normal' 

commercial venture this time.

How will The Blender Foundation be involved 
with the project alongside Fu Works?

I thi t hi the fi lm studio, 

uction 

les funding 

Obviously we 

ing open 

Blender – I 

we can even 

etter funding 

r that reason.

Interviewwith Ton Roosendaal

38

12 AMAZING THINGS YOU CAN DO IN BLENDER





T
his tutorial will guide you through the entire creation of 

artwork using Blender, starting from the blocking all 

the way through to the postprocessing phase. We will 

be guiding you through the creative process that is involved 

in creating a thought-provoking piece of artwork, while 

keeping the technical elements as simple as possible. The 

scene itself is rudimentary, however some of the shaders and 

textures are a tad more complex than they seem, and we will 

be guiding you through the entire material creation including 

some shader tweaks and scene optimisations for achieving 

fast and noise-free renders using the Cycles rendering 

engine. You’ll also see how dust eff ects can be added using 

Alpha-masked hand-drawn textures and some modifi er 

tricks that will add more realism to your models.

Render still life with 
Blender and Cycles

01 Plan ahead Before diving in on a project, make sure that the concept and story is as solid as it 

can get. There are usually two ways to do this: sketch the concept on paper and/or write a note 

about the details and idea of the concept – this ensures that you have laid down the initial foundation 

and will give you a broad sense of what you’re about to create. For this project, we experimented with 

not having a sketch to start with, but rather having a few notes to make the idea more concrete and 

feasible. It also helped to have an actual tangible reference – luckily, we had one on our desk. If you can 

come up with a title to work on as early as possible, the better, and most of the elements you’ll be 

adding later will revolve around this title. Don’t hold back in the planning stage, the better you’ve 

planned ahead, the smoother your project creation will be – too much planning can ruin it too. 

03 Block the scene Once your goals are clear, it’s time 

to actually start the creation process. This is one of the 

most daunting stages of a project and skipping it can 

demotivate you. However, once you’re aware of this fact, it’s 

easy to counter it. No matter how complex your model and 

scene will be, breaking it down into manageable bits and pieces 

gives you more control over the resulting output. The best way 

to do this is to use primitives like cubes, spheres and cylinders 

to average the scale of the scene as well as their relative 

relationship with one another. You can then decide if one angle 

or aspect of your composition is working or not, before 

spending time on the laborious details later on.

02 Build your references This is the stage where you 

put your researching skills to the test. Exhaust all your 

available resources: Google search, actual photos, tangible 

objects, sketches and so on. This will give you a better 

understanding of how certain materials and textures behave, 

especially if you couldn’t have found them elsewhere. It will also 

give you more options to choose from in terms of colours and 

details. It strengthens the concept and idea that you already 

have, exposing other aspects that you might have missed. 

Create a visually compelling story using realistic textures 
and image-based lighting, all with simplicity in mind

REYNANTE M 
MARTINEZ
Empty, 2015

Software
Blender, Cycles

Learn how to
Block out the scene and its 
overall composition

Create believable shaders 
using Cycles nodes

Develop a harmonious and 
minimal lighting scheme

Add dust eff ects using 
image-textured planes

Apply postprocessing eff ects 
using Compositing nodes

Concept
This piece, Empty, is a visual 
portrayal of one of the most 
diffi  cult stages that artists and 
creators go through. And 
having gone through this a lot, I 
wanted to share the emotion 
that goes with it.

03

01

02

 RENDER STILL LIFE WITH BLENDER AND CYCLES

DOWNLOADS
from fi lesilo.co.uk/3dartist

FREE
YOUR

Make a connection
Regardless of what genre you are working on and what 

style it has, make it believable as much as possible – this 

ensures that your viewers can relate to your piece and 

not just see a bunch of pixels on screen screaming 

colours and values. Create a visual harmony with the 

elements of your scene that will reinforce the message 

and story you’re trying to convey. At the end of the day, 

it’s the message that is most powerful in your artwork.
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ahead, the 
smoother your 
project creation 
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 RENDER STILL LIFE WITH BLENDER AND CYCLES

Simplify asmuchaspossible
Often as artists, we are tempted to add extra details that wouldn’t otherwise be seen. This

is good if you have all the time you need, but in most scenarios, it’s best to keep the details

in moderation where needed and emphasise the necessary complexities in the main

subject of your shot or scene. Not only is this beneficial to your time as an artist, which

means you can work on more important things, but this is also technically more efficient,

saving your computer the computation needed to calculate extra details (poly, texture

sizes and so on). Work smarter, not harder.

04

05

06

07

06 Create the displacements The text on the bottle 

might not be noticeable but it is this kind of subtle 

detail that adds believability. Using image textures as shader 

displacement might work well; however, doing the mesh 

displacement method looks more convincing in terms of how 

light behaves when it strikes the object’s surface – at the cost of 

more polygons and memory. To do this in Blender, create a 

separate UV map, add a Multires Modifi er to ramp up the 

amount of subdivisions, as well as adding a Subsurf Modifi er to 

further pronounce the density, and fi nally using the Displace 

Modifi er with the image texture assigned to create an 

embossed eff ect.

04 Model the glass jar To create the main subject of the scene, we’ll use traditional poly 

modelling techniques. Start off  with a circle with 32 vertices triangulated and merged in 

the middle. Select the outer edge and perform several extrusions and scaling. Continue with this 

procedure until you have completed the base shape with thickness. Finally, apply a Subsurf 

Modifi er to smooth the object. Keeping the topology as simple as possible enables us to have 

more control over the form and will ease the process of texturing later. This same principle is also 

used in modelling the cup, saucer and books in the background.

05 Texture the glass jar Since the glass jar takes up most of the visual information of 

the scene, it is necessary to add more realism to it by adding convincing textures. Create 

a simple UV map of the model and assign a scratch texture, which will indicate slight wear and 

tear, but keep it subtle. You can also add a Noise Texture and use it as a Normal map for the 

shaders, which is basically a mix of the Glass and Transparent Shaders. Doing this creates the 

illusion of depth and breaks the uniformity of the glass refraction.

07 Model the Sharpies Using the same technique 

described in Step 4, we’ll build the Sharpies starting off  

with a fi lled circle primitive, while keeping the scale relative to 

the glass jar. Duplicate the fi nished model and position them 

manually. There have been several attempts to try to automate 

the process via rigid body physics but it ended up too chaotic 

and unpredictable; doing it manually will give you more creative 

freedom as to their composition and arrangement.
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08

09

08 Texture the Sharpies To achieve the colour variation for the Sharpies, a separate 

material is assigned for the head portion. The same is true for the body, which contains 

diff erent texts used as image textures. Doing it this way makes it easier to tweak the individual 

material settings however you wish. The Sharpie heads are a simple combination of Diff use and 

Glossy Shaders with scratch displacements. The body, however, is a little more advanced, 

utilising several nodes to get the unevenness of the surface and texture.

09 Add the leaf 

Using the ‘Image as 

Planes’ add-on in Blender, you 

can add image textures with 

transparency masks easily. 

But the real beauty is in 

tweaking the material 

settings. Using a very simple 

Diff use and Glossy Shader 

mix, you can achieve a fairly 

realistic leaf without having to 

do any complex modelling. 

However, if the leaf would 

have been in focus, there 

might be a need to model it 

instead for more clarity and 

realism. This texture trick 

works for this scene since the 

leaf won’t be much in focus.

Reynante M Martinez
A self-taught artist and a Blender user for 11 years, 

Reynante specialises in visual storytelling and lighting. 

He has a background in graphic design, photography 

and illustration to name a few, with industry 

experiences that include academic teaching, art 

direction for short fi lms and architectural visualisation.

Rock On Blender, Cycles (2015) 

This is my tribute to the scorching hot season that occurs in 

my country (Phillipines).

Playtime Blender, Cycles (2015) 

Another doodle to express my odd imaginations and to detract 

from my usual routines for a while.

Fear Blender, Cycles (2014) 

Inspired by a spontaneous idea that thoughtfully made its way 

into my consciousness on a random day.

 Using a very 
simple Diff use 
and Glossy Shader 
mix, you can 
achieve a fairly 
realistic leaf
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 RENDER STILL LIFE WITH BLENDER AND CYCLES

Compositionwith lighting
Lighting plays a huge role on how believable your scenes will end up looking because

well-composed light rigs can amplify the details of your objects and make them pop even

more than before. Lighting can even add contrast to the layers of your composition so that

we get a harmonious relationship between all of the objects in our image. Make sure that

you make full use of settings like energy/strength, size and colour to further enhance the

overall look of your renders.

12

13

10

11

10 Set up the camera Once your models are set up, it’s 

time to create a composition which will highlight and/or 

hide the elements in your scene. For some, this is one of the 

most crucial stages of the workfl ow process because 

composition plays a huge role in telling your story. In Blender, 

the Camera is just like any other object where you can apply 

rotations and translations as you wish. And to further 

emphasise your subject, you can use an Empty object as your 

‘Depth of Field’ (DoF) focal point, while dialling the F-stop 

settings to control how shallow the blur eff ect is.

12 Image-based lighting (IBL) Using high dynamic range (HDR) images has been one 

of the most eff ective ways to illuminate a scene. Often, even with the absence of any lamp 

types. However, one downside to using them is that they take up too much memory, which is 

most evident when using large images with a high-bit depth. To balance this out, have an 

alternative lower-resolution image with a relatively higher bit depth than ordinary images like JPG 

or PNG. These IBLs also provide a great environment refl ection on refl ective objects. Via the 

node system in Blender, you can tweak and enhance the eff ects of IBL, where you can create 

more pronounced shadows and higher light intensities.

13 Additional lighting with Sun This step is optional. Adding extra light sources to your 

scene can make or break the intended visual composition. Always ask yourself what the 

purpose is to adding the lights. In this case, we are adding a Sun Lamp to further exaggerate the 

shadows and enhance the silhouette of the objects in the scene. To fully utilise this, use the 

lamp’s size controls to modify how sharp or soft the shadows will be. You can disable any extra 

information like Diff use, Specular and so on, and just keep shadow casting active if you wish to.

11 Fake the interior environment Often, it’s not wise to 

entirely design the interior architecture of a project, 

especially when the focus is solely on an object where 

everything is blurred out. However, adding simple shapes to 

block out the basic form of the space is suffi  cient to create an 

enclosed space where light could bounce in as well as creating 

shadowed and unlit areas.
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 Lighting plays a huge 
role in how believable 

your scenes will look
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 RENDER STILL LIFE WITH BLENDER AND CYCLES

All tutorial files can be downloaded from: filesilo.co.uk/3dartist

Animationpostprocessing
Blender’s Compositor is not only constrained to processing still images. Its true strength

lies in animated sequences and/or RAW video files. Most of the settings (values, sliders,

checkboxes) in each node can be keyframed according to any changes that have occurred

in your animation and sequence. The processing of high-bit depth images like OpenEXR,

HDR and Targa is also possible and is recommended when you want to perform any

postprocessing operations.

14

16

15

17

16 Lens eff ects Imitating traditional lens eff ects can add another level of believability and 

realism to your renders. This breaks the computer-generated look that your raw renders 

have. It will also psychologically imply a natural phenomenon that is usually seen through 

traditional and digital cameras alike. Camera imperfections like vignette, chromatic aberrations 

and grains are among others that imply realism. In Blender, these are available via the nodes 

carefully placed one over the other.

14 Create the dust Usually, dust eff ects are added in post after the image has been 

rendered, using tools like Photoshop or GIMP. However, adding them into the render gives 

you more realistic results like depth-of-fi eld eff ects, volumetrics and the like. One way to do this 

is to draw random lines and use these images as Alpha masks mapped to planes, then using a 

particle system to distribute them across the entire scene.

15 Colour and contrast enhancements 

Postprocessing has already been a part of major artistic 

workfl ow since the past couple of decades – and this is true for 

photography as well. The trick to doing this lies in moderation. 

Using Blender’s Compositor is a great way of nondestructively 

enhancing the render, which works best when the raw render’s 

format is a high-bit depth image. Using several nodes, we can 

enhance the colours and contrasts of the image thereby adding 

more visual quality.

17 Film emulation To fi nish the postprocessing eff ects 

on the image, apply a combination of fi lm eff ects, preset 

looks and gamma adjustments. There are no hard rules to this 

and it’s best to use your own visual taste and judgement. As 

mentioned in the previous steps, just make sure you keep it 

simple and subtle. In Blender, these settings are accessible 

under Scene tab>Color Management.
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I
n this tutorial we are going to learn modelling skills, 

concept design skills, shading techniques and other things 

that are needed to create a convincing mech. The most 

beautiful part of the tutorial is when you are designing it 

because you are giving birth to an idea.

So we are going to start by learning how to do a quick and 

rough design, then we are going to pass it to Maya for doing 

the high-resolution model, where we are going to fi nd 

common modelling issues and learn how to tackle the UVs. 

Once we have the model in Maya we will discuss the shading 

and texturing, we will cover how to replicate materials from 

real life, discuss concepts like Fresnel, glossiness, BDRF and 

so on. Finally we are going to learn about compositing, where 

we are going to give the render our fi nal touches.

Construct a 
futuristic mech

01 Come up with an idea The fi rst thing to do is come 

up with an idea; a style that you want to follow. Start 

looking for references in that style. The proper thing to do is 

take your time to think about what type of artwork you are 

going to create. Don’t forget that this is a creative process so 

keep an open mind and explore ideas.

03 References Once you decide the style that you are 

going to follow, it’s important to gather as many 

references as you can in that style. Referencing is important 

because it keeps you focused on following the lines of design 

that you can compare with your project.

02 Get inspired Next step would be to look into other 

similar pieces of artwork and look for any kind of 

inspiration that can guide you through the creative process, so 

check out these pages: artstation.com, cgfeedback.com, itsart.

com, cgmeetup.com, and zbrushcentral.com. It’s important to 

keep yourself inspired and up to date.

Build a mech using Mayan/primitive elements, model with 
quads and make use of diff erent materials

MARIANO 
TAZZIOLI
Hawk Mech, 2015

Software
ZBrush, Maya, 3ds Max

Learn how to
Model concepts 

Fix common modelling issues

Build complex pieces out of 
simple ones

 Model hard surfaces

 Use retopology

Make a UV layout

Clean the scene

Texture

Build high-resolution shaders

Composite

Concept
Since the beginning I knew I 
wanted to do a Mayan or 
primitive type of mech, so I 
started to look for references 
of Mayan art and then 
developed my idea from that.

0301

02

 CONSTRUCT A FUTURISTIC MECH

DOWNLOADS
from fi lesilo.co.uk/3dartist

FREE
YOUR

Keep an open mind
Since this is a creative process, it’s good to keep an open 

mind and keep trying things. If something doesn’t work 

change it with something else; you can make radical 

changes to a design element if you think it’s really 

necessary. So in that way you always keep your mind 

active and you will keep looking at new ways of making 

your design look cooler.
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following the lines of design 
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your project 



 CONSTRUCT A FUTURISTIC MECH

04

05

06

07

06 Open your mind This is a creative process so if a 

design element doesn’t work, just try something else. 

It doesn’t have to be similar to the previous element – you can 

make a radical change, but don’t settle with your design. Keep 

changing things and if it looks right then good, and if it not then 

try something else.

04 Start sketching ideas Once you know more or less what you want to do, it’s time to 

get into ZBrush and start to sketch some ideas. Now you don’t have to model 

everything perfectly here or defi ne anything necessarily, you just have to do a rough design so 

that later you can start the fi nal model and this will only serve us as reference. Here we are using 

ZBrush for the design.

05 Moving things around As this is a purely creative process, you can start moving and 

creating geometry separately – so the workfl ow that we use for this type of artwork is 

always the same. We start from a base mesh, then we start to mask parts, extract and deform 

geometry to create the shape we want, or we can just create a new primitive and start deforming 

it as well. However, by extracting you can stick this piece of geometry to the base mesh to follow 

the shape.

07 Move on to the fi nal model Once you have your 

design fi nished, import the rough design to Maya by 

fi rst decimating it in ZBrush. Once in Maya you can start to do 

the retopology of the pieces or model them. Since in ZBrush we 

did a quick design, all the pieces are undefi ned so now in Maya 

it’s time to defi ne them and give them the fi nal look. The more 

you can defi ne in ZBrush, the less work you’ll have to do later.
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09

10

08 Modelling techniques Quads are your friends, and 

triangles are kind of your friends – the ones that are 

not friendly are the ngons. In hard surface, since the pieces are 

not supposed to deform, you can keep triangles where the 

topology may require them, but try to always have the 

maximum amount of quads available to you.

09 Common tools Although the fi nal design may look 

complex and it may have lots of details, all the pieces 

are done in the same way by using the Extrude, Knife and 

Merge tools. The illusion of complexity is done via the 

repetition of elements and the union of various simple pieces. 

As shown in the video tutorial, all of this can be done by using 

simple primitives, duplicating them and giving interesting 

breakups to the pieces. It works in the same way that you can 

achieve a sense of depth by repeating columns with a long 

straight line as you do in 2D art. Here you can achieve the 

complexity by repeating and varying the same elements.

10 Optimise the model Only use the quantity of loops 

that you really need for your model. For a hard edge you 

only need three loops, as you can see in the image to the left: 

there is a main loop and then only three more loops for support 

and for creasing the edge. The closer those loops are together, 

the harsher the edge; putting more edge loops in will only make 

your scene heavier.

Reference
It’s a very good idea to 

save all the references 

that you like, for 

example use a huge 

reference library of 

other artist works as a 

reference point to study 

from and for 

inspiration. You can 

learn a lot by simply 

observing other artists 

and their work. If you 

are lucky, some of 

these artists may also 

provide you with some 

tutorials or techniques 

that you can learn from.
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Alwayskeepupdated
A good thing to do is obviously never stop learning; keep searching for and developing new 

techniques that will enable you to arrive at the same result but quicker and more efficiently. 

Learning things like Python is a very good idea because it allows us to achieve more of 

what we want easier.

12

11

12 Build a shader ball 
For testing and 

defining the shaders, it’s a 

good idea to build yourself a 

testing shader ball and put it 

in a scene with an HDRI and a 

few more lights to put some 

highlights in the scene. That 

way you can develop your 

shaders in this ball with a 

simple but effective light rig 

and develop the shaders 

consistently as well.

13 Analyse the shader A great resource for learning shading is the course by Grant 

Warwick (masteringcgi.com.au). We are going to be using V-Ray for shading and the first 

thing to do is look at your references and identify the components of the shader you are trying to 

re-create: if it’s metal or plastic, whether it’s made up of one or two or more coats, whether it’s 

the same material or if there are more than two materials used. For the latter, take a look at this 

wheelbarrow below, which is of a blue material with dust on top (a different material).

11 Simplify your UVs Once you finish modelling it’s time

to do the UVs. The UVs can look complex but remember

that this complexity can be achieved if we make sure that there

is a union of simple pieces. With this method, you will end up

with a very complex piece made up of simple ones and with it

will come easy UVs too. Another thing you can do is: when you

are giving a double surface to a piece, instead of extruding it

you can select the border edges and extrude them so that you

only have those edges instead of a back face.

 It’s a good 
idea to build 
yourself a testing 
shader ball and 
put it in a scene 
with an HDRI 
and a few  
more lights

13
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Lookat real-worldmaterials
One thing that you should is to always look at real-world materials and analyse them to

understand what is going on. Move around the object that you’re physically looking at to

understand how it reacts to different viewing angles and lighting. That way you will see

common patterns in the materials, like fingerprint details that almost all materials have.

14

16

15

17

16 V-Ray blend materials To create multiple coats of material you will need to create a 

V-Ray blend material and then choose the material that you want as your base shader 

and also as your base coat in your V-Ray blend. Then, for creating a layer of dust, create another 

V-Ray material and put it as coat1 and follow the same steps as before but change the colour to a 

more brown desaturated colour. Next put in an image as a mask in the blend1 slot to add a dust 

layer on top of the base shader. Another cool feature that we can use here is the V-Ray dirt 

material and you can use this to add dust in the more occluded areas. 

14 Define the shader Create a V-Ray Standard material and try to match the colour of 

the base material. Untick Fresnel in the reflections, put in a Falloff map, then in the ouput 

tab tick Enable Ramp. Now you can define the Fresnel curve – Fresnel is the effect where the 

reflectivity increases as we start to look at the object with angles close to 0 or 10 degrees and the 

reflectivity decreases as we start to look at the object with 90-degree angles. If you know more 

or less which material you are trying to re-create then you can look up the reflectivity curve, for 

example on the page refractiveindex.info.

15 Parameters and modes We will be using two  very 

important modes in this step: mono for a black-and-

white reflection, and RGB, which allows you to control different 

colours independently and tint the overall reflection. In the 

glossiness setting, try your best to put in a number that 

matches the reference, then for breaking a bit of the specular 

you can output a map in the glossiness. Another important 

parameter for you to consider is the BRDF: this is a function 

that determines how the specular is distributed along the 

surface. Ward works fine with metal, and phong or blinn works 

for plastics and similar materials.

17 Compositing Once we import the render into After 

Effects we can add curves to add more contrast, and 

then use a beam effect to define the rays from the eyes in Add 

mode. If we want to add some glow effects, for example in the 

red spots, you can create a red solid and use a mask in Add 

mode to create this effect. Then for a more sci-fi look you can 

use optical flares. You can also use Magic Bullet, which is a very 

nice plugin for adding final touches to the piece (redgiant.com/

products/magic-bullet-suite).
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KeyShot®
Amazing renderings and animations. In minutes.

Model by Steve Talkowski

Sketchbot.tv

Learn more at

keyshot.com/keyshot-6/

KeyShot 6 is coming soon. For a limited time only, purchase or 
upgrade KeyShot 5 and receive a free upgrade to KeyShot 6.

Import your model file 
into KeyShot

Drag-and-drop to 
apply your materials

Set the camera for 
the perfect shot 
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I
n this tutorial we will go through the steps to create a posed and detailed creature. Starting 

with only a sphere we will create the rough form of the creature and use ZSpheres to add 

limbs. We will also make use of readily available Insert Multi Mesh brushes to add features 

to the creature. After posing the creature we will use Polypainting to create basic materials 

and textures on the model. Finally, the 3D renders will be taken into Photoshop to finish the 

composition by adding lighting effects and textures. We will also cover how to export and 

render the model in KeyShot from ZBrush 4R7.

Awaken a beast 
with ZBrush
Model, pose and texture a monstrous creature’s life 
cycle and its natural setting
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 It is a good idea to choose 
an Alpha material to paint with 

to blend colours in a more 
natural way  
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03 Sculpt the initial
details The next 

step is to add character and 

realism to the model by 

sculpting basic skin folds and 

muscle structure. Using the 

ClayTubes and Smooth 

brushes we can quickly create 

the look of skin folds or 

wrinkles. The Dam_Standard 

brush is great for carving lines 

and wrinkles as well as 

carving out the mouth and 

nostrils. During this stage you 

may need to use DynaMesh 

again to smooth the mesh 

out. Next, add the eyes by 

inserting spheres. Then 

mirror the spheres using the 

SubTool Master plugin and 

move the eyes into place with 

the Transform tools.

04 Create the arms with ZSpheres To create the forearm we will start by inserting a 

ZSphere into the model. Press Q and you can draw out a new ZSphere and after 

pressing W you can drag the new sphere out further to create the fi rst part of the arm. By 

repeating this process you can create the basic form of the arm, the Scale and Rotate tools can 

also be used. When you are happy with the arm click on Make Adaptive Skin under the Adaptive 

Skin menu. This new SubTool can then be added to the main SubTool, it’s usually best to run 

DynaMesh before sculpting further.

 AWAKEN A BEAST WITH ZBRUSH

04

03

01 Create a rough 
bust First insert a 

new sphere. Press T to edit 

the object and click Make 

Polymesh3D, also activate 

Symmetry by pressing X. 

Now with the Move brush set 

to a large size (by pressing 

the ] key), push the shape 

around. The idea is to quickly 

explore your ideas without 

worrying too much about 

what the details will be. At 

this point it’s sometimes 

useful to look at reference 

images of the anatomy of real 

animals or insects.

02 Develop the 
model using 

DynaMesh Now we have a 

very rough form but the mesh 

is becoming diffi  cult to sculpt 

because of its topology. We 

need to use the DynaMesh 

feature to even out the 

surface of the model. We can 

then continue to pull out the 

basic form of the creature. 

When it feels like the 

polygons are stopping you 

from adding more detail, just 

use the DynaMesh feature 

again but with a higher 

resolution. At this point the 

polygon count is quite high 

and we can start using the 

Clay brush to carve in smaller 

features such as the eye 

sockets and skin folds.

01

02

Choosing a full 
body or bust
When you start a new 

character you may not 

be sure how the entire 

character will look. It’s 

a good idea to 

concentrate on 

sculpting a bust, as this 

helps you develop your 

character. You can 

always create the rest 

of the character from 

ZSpheres or Insert 

Meshes and merge it 

with DynaMesh. In 

ZBrush 4R7, when you 

use DynaMesh on a 

SubTool with multiple 

objects merged, it 

preserves the individual 

objects’ Polygroups.

JAMES SURET
Newborn, 2015

Software
ZBrush, KeyShot, Photoshop

Learn how to

Concept

DOWNLOADS
o fi lesilo.co.uk/3dartist

FREE
YOUR
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05 Develop the 
anatomy Now we 

have a sculptable arm we can 

mirror the SubTool using 

SubTool Master menu under 

Plugins, if you choose the 

option to Merge into one 

SubTool you can then press X 

to enable symmetry on the 

arms. Then using the Move 

and Clay brushes you can 

build up the anatomy of the 

arm; consider where the 

joints will protrude and skin 

folds might hang from. To 

complete the creature we can 

now add a new sphere and 

pull out the basic shape of the 

lower half of the creature’s 

body and tail. Now use 

DynaMesh to prepare the 

SubTool for sculpting.

06 Use Insert Multi 
Mesh brushes 

Now that one set of arms is 

sculpted you can add more 

by clicking Duplicate in the 

SubTool menu. The new arms 

can then be resized and 

moved by making use of the 

Transpose tools. To speed the 

modelling process up we can 

add some legs to the creature 

by using a premade Insert 

Multi Mesh brush pack 

available for free at badking.

com.au. Once the brush set is 

loaded up you can then click 

on the side of the creature’s 

body and drag out the size of

the leg that you want it to be.

Then you can use the

Transpose tools to position it.

05

06

07

07 Detail the face 

Now the large forms 

of the creature are complete 

we can focus on adding detail 

to the smaller areas. Using 

the Dam_Standard brush you 

can create more skin folds 

and wrinkles. It is useful at 

this point to use DynaMesh 

again at a higher resolution to 

enable you to sculpt these 

smaller details. We can also 

add in some teeth by starting 

with a sphere, pulling out the 

basic shape and then 

duplicating the SubTool as we 

did before when we were 

working on the arms.

James Suret
I am currently a full-time web developer and freelance 

3D artist. I am constantly developing my portfolio with 

the aim of working as a concept artist in the games/

entertainment industry. My main focus is creating 

original creatures and illustrations.

Oculus ZBrush, Photoshop (2013)  

This sorceress character was sculpted in ZBrush, using Insert 

Multi Mesh Curve brushes to create the clothing.

Nova-25, Photoshop (2013)  

This is a futuristic character concept. I sculpted this female 

cyborg character in ZBrush, using FiberMesh to create the hair.
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Posing forms
When posing organic

characters you usually

need to create smooth

bends, for example, the

neck or knee. When

you are painting out a

mask you can hold

down the Ctrl key and

lower the RGB opacity

which will draw out a

softer mask. This will

create smoother, more

organic bends. You can

quickly blur the mask

by using Ctrl+click

several times.

08

1009

11

12

11 Make the background Now that we have the 

creatures and the foreground ready we can make a quick 

background for the environment. Start by pulling out a sphere 

with the Move brush into a rough rectangle. Use DynaMesh 

and then pull a tunnel shape out of the back of the model with 

the Move brush. Continue shaping the cave and using 

DynaMesh to help sculpt more detail. You can also use Alpha 

materials to quickly add some texture but don’t worry too 

much about sculpting details as the background will get blurred 

out in the final image to create a depth-of-field effect.

09 Create the 
landscape Now 

we need to create a base 

environment for the creatures 

to exist in. Starting from a 

sphere again we can rough 

out a rocky platform with the 

Move and Clay brushes; use 

DynaMesh to smooth out the 

mesh after large changes. 

When the polygon count is 

high enough, use Alpha 

materials to add a rough 

surface to the model. Then 

load the IMM Clod brush that 

comes with ZBrush and insert 

some rocks along the surface. 

Use the Transpose tools to 

resize and rotate each rock as 

you are inserting them. You 

can now also duplicate the 

SubTool containing the baby 

creature. It can be scaled up 

slightly and positioned near 

the front of the egg with 

Transpose tools.

10 Pose the creature Now we can pose the creature to fit into the environment. Before 

we do it’s a good idea to merge the eyes and teeth down into the main body SubTool so 

they will be posed together. Make sure they are listed underneath each other in the SubTool list 

before clicking MergeDown. With the body SubTool selected hold down Ctrl and paint a mask 

covering the head and neck. Turn off symmetry by pressing X, hold Ctrl down and click outside of 

the model to invert the mask. Press R and draw out a transpose line from the base of the neck 

outwards then drag the end of the line to rotate the neck. You can then use the same method to 

pose the rest of the body and limbs as well as the larger baby creature’s limbs.

08 Create the egg 
and baby The egg 

is created by inserting a 

sphere and roughing out the 

shape with the Move tool. 

Then use DynaMesh and 

tweak the shape further. You 

can use Alpha materials to 

quickly sculpt surface details. 

To create the baby creature, 

make the basic skeleton from 

ZSpheres based on the 

anatomy of the original 

creature. Then move the 

skeleton inside the egg and 

position the limbs. To move 

the ZSphere model press W, 

hold Alt and click on the initial 

inserted ZSphere. After 

turning the model into an 

Adaptive Skin, use sculpting 

brushes to add detail.

12 Final details Now to complete the sculpt we can add fine surface detail. Add a fine layer 

of noise to the model to make the skin look more realistic. Click on the Noise button under 

the Surface menu, here you can tweak the strength and scale of the noise. To apply this noise to 

the model click OK then Apply To Mesh. You can then use different Alpha materials to layer hard 

and sharp textures on the skin to create the look of bumps, veins and scratches on the skin. A 

great selection of free Alpha materials can be found at pixologic.com/zbrush/downloadcenter/

alpha. Alternatively you can create your own from photos by saving them as greyscale PSD files.
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 Use different 
Alpha materials to 
layer hard and 
sharp textures on 
the skin  

13

13 Polypaint the base textures Firstly, fill the model 

with a plain material by clicking MRGB and selecting 

MatCap White01 as the material and FillObject in the Color 

menu. Make sure ZAdd and ZSub are not ticked (so you don’t 

accidentally sculpt on the mesh) and tick RGB (this will allow 

you to just paint in colour). It is a good idea to choose an Alpha 

material to paint with to blend colours in a more natural way. 

Then, apply some base materials to enhance the texture’s 

shading. To do this make sure only M is ticked, select a material 

and click FillObject from the Color menu.

Polypaint with masks
After you have finished painting the creature a good way 

to bring your sculpted details back out is to use the Mask 

By Cavity button under Masking, then invert the mask. 

Now you will have all the deeply carved details selected, 

such as skin folds and pores. You can then paint with a 

darker skin colour over these areas only. Clear the mask 

and you will be able to see the difference it makes.
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All tutorial fi les can be downloaded from: fi lesilo.co.uk/3dartist

The right view
When trying to decide 

the best camera angle 

for your fi nal render, 

consider the Rule of 

Thirds or the golden 

ratio. Render a camera 

angle that you like and 

overlay an image of the 

golden ratio (search 

Google Images), see if 

the image’s features 

match up with the 

spiral centre and then 

adjust the camera 

angle accordingly. 

14

15 16

17

15 Composite the layers in Photoshop After saving the renders as PSD fi les open 

them in Photoshop and layer them up. First the background render and then main BPR 

render, followed by the AO layer set to Multiply which helps add more depth to the render. Next, 

set the specular layer to Lighten which brings out highlights along the skin. Finally, set the shadow 

layer to Darken to enhance the dark areas. The mask layer can be used to delete the background 

of the renders to enable you to place the background render behind the character.

14 Lighting and rendering First we need to rotate the model to create an interesting 

composition. Then select the background SubTool and press the Solo button to only show 

this SubTool. Use the BPR render to create the background image. Next turn off  Solo mode and 

hide the background SubTool. Move the light placement by moving the dot around the sphere 

under the Light menu. Set the shadow resolution to 8,000 on the BPR Shadow section of the 

Render menu to create higher quality shadows. Enable Ambient Occlusion under Render 

Properties and set the resolution to 8,000. Click BPR to render and save all the render passes. To 

create a specular render, fi ll the model with Toy Plastic material and black colour. Finally we will 

create a clown pass render to help select individual parts of the model in Photoshop. Fill each 

SubTool with the Flat Color material and fi ll each part with a diff erent colour, then render this out.

16 Add eff ects and textures Apply a strong Gaussian 

blur to the background to create a depth-of-fi eld eff ect. 

Next, insert stock photos of skin and bone to enhance the 

textures on the character; set them to Overlay and reduce the 

opacity. Using the Clone Stamp tool you can paint these extra 

textures on diff erent parts of the creature. A great selection of 

free photo textures can be found at cgtextures.com. Finally, 

using a soft brush, add some soft lighting and glow eff ects to 

the teeth, eyes and skin. This emulates refl ected light and adds 

to the atmosphere of the image. To create the strands of slime/

saliva you can draw a line with the Line Tool and then use the 

Warp transform tool to make it look more realistic.

17 Render in KeyShot Rendering in KeyShot is now easier than ever with ZBrush 4R7. 

Simply load your model as normal and click on the External Renderer button under the 

Render menu, then hit the BPR button. The model and all of its texture/materials will be sent to 

KeyShot. If you want to create a realistic clay render you can apply one of the clay materials that 

comes with KeyShot. For more realistic lighting, load one of the HDR environments, set the 

Background to Color and choose a light colour. You can also rotate the lighting by using the slider 

under the Environment tab. When you are happy press Render and choose your resolution.

To create the strands of slime/saliva you can draw a 
line with the Line Tool and then use the Warp transform 
tool to make it look more realistic  
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I
n this tutorial, we will continue working on the arm rig from

where we left off last time in Part 1. This time, we will focus

on the fingers. We normally use an FK-only based setup and

use Set Driven Keys to hit a range of poses quickly, with

additional controls to pose each digit of the fingers. On this

occasion, however, we will use the fingers to interact with a

ground plane (imagine the Thing from the Addams Family).

We are going to go for an IK-based setup that then drives an

FK rig. This will let us keep the fingertips locked to a certain

position but still offset each digit should we wish to do so.

We’ll also add the functionality that the IK rig can either

follow or not follow the main arm rig. That way, if you wish to

animate the fingers in FK mode only, the IK won’t stand in

your way.

We’ve prepared scene files for you so we can kick things

off  straight away. You’ll fi nd the start fi le on FileSilo in: 

scenes/02_rigging/part2/00_start.ma. This is pretty much 

where we left off  last time; the only diff erence is we’ve gone in 

and chopped up the low-resolution geometry for the fi ngers.

01 Create the fi nger joints Let’s get things going by 

creating the fi nger joints. Jump into the Front view and 

create a fi ve-joint chain for the index fi nger. First click at where 

you feel the metacarpal joint should go, then at the fi rst knuckle, 

then at the second knuckle, at the third knuckle, and lastly, 

create a joint at the tip of the fi nger. As you create the joints that 

will sit in the fi nger, add a slight arc to the joints (like a rainbow) 

so that the IK handle will be able to pick up the bend point. Next, 

select the root joint of the new chain and go to Skeleton>Orient 

Joint (Options). When the dialog box pops up, set the Primary 

Axis to X, the Secondary Axis to Z and the Secondary Axis 

World Orientation to Z (-). Positive Z rotation should now be 

flexing the fi ngers. Now rename the joint chain from root to tip 

like so: ‘indexA_bind_jnt’, ‘indexB_bind_jnt’, ‘indexC_bind_jnt’, 

‘indexD_bind_jnt’ and ‘index_end_bind_jnt’. Jump into Top 

view, select indexA_bind_jnt and hit Cmd/Ctrl+D to duplicate 

the joint chain. Select the root joint of the duplicated chain and 

translate it for the middle fi nger. Repeat the process for the ring 

finger, pinky and thumb. For the thumb, delete the end joint as it 

has one too many and rename the joints.

Use Set Driven Keys 
to rig a hand
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Skinning thearm
Once you are happy with the rig, you’ll want to use it to

drive the geometry. You’ll want to start by selecting all

the _bind joints and dropping them into a Quick Select

Set. With the joints still selected, add the arm that we 

want to bind to the selection and go to Skin>Bind Skin 

(Options) and use the following settings: Bind to: 

Selected Joints, Bind method: Geodesic Voxel, Falloff: 

0.3 and Resolution: 1,024. All the other settings can 

stay as they are. Now test out deformations using the 

rig in both FK and IK modes. 

02 Position and rotate all the 
finger joints Now that we have all 

the main joints, start positioning and 

orientating them into place. Remember that 

you can translate and rotate the root joint in 

any axis but for all children joints, you should 

only use Translate X. You can, however, rotate 

all the joints on any axis. Once you have 

positioned all the joints, go to Modify>Freeze 

Transformations to remove all the rotational 

values. With the joints in place, select the 

<finger>B_bind_jnt of each chain and hit 

Cmd/Ctrl+D to duplicate it. Select all the 

duplicated joints now and go to 

Modify>Search and Replace. In here, set the 

‘Search for’ to _bind_jnt and the ‘Replace 

with’ to _ik_jnt. You’ll also need to go in and 

remove the one hanging on the root joint for 

all the IK chains now. With all our joints in 

place now, take the low-res geometry for the 

fingers and then parent the relevant piece 

under the relevant _bind joint, and we will do 

this so that we can check the behaviour of the 

rig as we go.

03 
Create IK handles and controls 
Select all the _bind_jnt chains and 

then hit Cmd/Ctrl+H to hide them for now so 

we can focus on the IK chains. For each IK 

chain, create an IK handle (Rotate-Plane 

Solver) starting from <finger>B_ik_jnt and 

ending at <finger>_end_ik_jnt. You should 

now have five IK handles. Make sure to go in 

and rename them like so: ‘index_ik’, 

‘middle_ik’, ‘ring_ik’, ‘pinky_ik’ and ‘thumb_ik’. 

Now select them one at a time and test how 

they affect the joint chain. If you are not happy 

with them, repeat Step 2 until you are. Next, 

create a control for each IK handle using the 

same process that we did in the previous 

tutorial, or like we have done here, simply 

duplicate the wrist_ik_ctrl and then use that 

shape. Here is a quick recap of getting the 

control to drive the IK handles: create a 

NURBS shape and rename it appropriately, for 

example name it like so: ‘index_ik_ctrl’. Next, 

group the curve to itself twice. Then go ahead

and add the suffix ‘_offset’ to the top-most 

group and then ‘_sdk’ to the group above the 

control curve. Next, move the _offset node to 

the same positon of the IK handle (in this 

example this will be: index_ik) it will control, 

and lastly, point constrain the IK handle to the 

control curve (index_ik_ctrl). 

04 Create IK finger twist controls 
Let’s look at adding something 

similar to enable us to twist the fingers. Start 

by creating a NURBS curve (of any shape of 

your choice) and name it ‘index_twist_ik_ctrl’. 

Then create the control hierarchy using group 

nodes as we have done in the past. Next, we 

will need to position the control. To do this, all 

you have to do is just select the following 

objects in this order: indexB_ik_jnt, indexC_

ik_jnt, indexD_ik_jnt, index_end_ik_jnt, 

index_twist_ik_ctrl_offset, and go to 

Constrain>Point (make sure Maintain Offset 

is disabled). Now select in this order: 

indexC_ik_jnt, indexD_ik_jnt, index_twist_ik_

ctrl_offset, and go to Constrain>Aim. With 

our control correctly aligned, go into the 

Outliner, select the two constraint nodes 

under index_twist_ik_ctrl_offset and then 

delete them. You can now select index_twist_

ik_ctrl_offset and in Local translate mode, 

drag it out slightly so that it can be more 

easily selected than before. Next, select 

index_twist_ik_ctrl, then Shift+select index_ik 

and go to Constrain>Pole Vector. That’s one 

down. Now just repeat this step for the 

remaining fingers. To add an extra method of 

twisting the fingers, add the attribute ‘twist’ to 

all the IK finger controls (leave the Min and 

Max blank). If you duplicated the IK wrist 

control as we have done, then this attribute 

will already be present on your IK finger 

controls. Now go to Windows>General 

Editors>Connection Editor, and add index_

IK_ctrl to the left column and index_IK to the 

right column. Now just highlight ‘twist’ in both 

the left and right columns and we should be 

good to go. Again, you can repeat this step for 

all the other fingers. 

02

03

04
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that manually. For the index finger (you can 

repeat this for all the other fingers) select 

indexD_fk_ctrl_offset and parent it under 

indexC_ctrl. Then take indexC_fk_offset and 

parent it under indexB_fk_ctrl. And lastly, take 

indexB_fk_offset and parent it under indexA_

fk_ctrl. The FK controls will now drive the 

rotations of the joints, they will not, however, 

translate the root joint of each finger. For this to 

happen, select in this order: index_A_fk_ctrl, 

indexA_bind_jnt and go to Constrain>Point. 

Now all you have to do is repeat this for the 

remaining root joints.

06 
Connect the FK to the IK Now we 

will be connecting the output rotation 

values for the IK joints to drive the _drive group 

node on our FK controls. Let’s tackle this for the 

index finger. Select both indexD_fk_ctrl_drive 

and indexD_ik_jnt, and go to Windows>Node 

Editor. Open both nodes up fully and then 

connect the output Rotate attribute of 

indexD_ik_jnt into the input Rotate attribute for 

indexD_fk_ctrl. Do the same for indexC_fk_

ctrl_drive and indexB_fk_ctrl_drive. Then 

translate index_ik_ctrl around to see if it drives 

the FK controls. If all works well, repeat the 

process for the remaining fingers.

07 
Connect the fingers to the palm 
If we move the arm controls around, 

you’ll find that the fingers will stay as they are. 

Before we fix this, let’s clean up the Outliner. 

Select all the finger root joints and hit Cmd/

Ctrl+G, and then rename this group ‘fingers_

rig_grp’. Then select all the IK control _offset 

nodes and hit Cmd/Ctrl+G. Rename this group 

‘fingers_Ik_ctrl_grp’. With nothing selected 

now, hit Cmd/Ctrl+G twice and rename the 

top node ‘fingers_ctr_grp_offset’ and the 

group below ‘fingers_ctrl_grp’. Select the _

offset node and parent it under wrist_bind_jnt, 

zero out the Translate and Rotate channels to 

position the _offset group, and then hit Shift+P 

to unparent the _offset node. Lastly, take all the 

FK finger control _offset nodes and parent 

them under fingers_ctrl_grp. Next, select in 

this order: wrist_bind_jnt, fingers_ctrl_grp_

offset and go to Constrain>Parent.

08 
IK to follow or not follow We 

now want to create an attribute that 

will enable us to control whether the IK 

controls should or should not follow the rest of 

the rig. Before we do that though, and to make 

the tackling of this a speedier process, take the 

_offset node of each IK twist control and 

parent it under the relevant IK finger control. 

Now with nothing selected, hit Cmd/Ctrl+G 

twice to create two empty group nodes in a 

small hierarchy. Rename the top group 

‘fingers_ik_ctrl_grp_offset’, and the group 

below ‘fingers_ik_ctrl_grp’. Now select the _

offset group, parent it to wrist_bind_jnt, zero 

out all the Translate and Rotate channels, and 

hit Shift+P to unparent it. Take all the _offset 

nodes for the IK finger controls, and parent 

them under fingers_ik_ctrl_grp. Select in this 

order: wrist_bind_jnt, fingers_ik_ctrl_grp_

offset, and go to Constrain>Parent. Next, select 

fkIk_vis_switch_ctrl and go to Modify>Add 

Attribute. Create an attribute called ‘ikFingers_

follow’ and give it a Min of 0 and a Max of 1. 

Now open up the Set Driven Key window and 

load fkIk_vis_switch_ctrl as the Driver object, 

and the parentConstraint node living under 

fingers_ik_ctrl_grp_offset as the Driven object. 

Make sure the IK Fingers Follow attribute is set 

to 0, check the Wrist Bind Jnt W0 (on the 

parent Constraint node) is set to 0, and hit Key 

on the SDK window. Then set both attributes 

to 1 and hit Key once more. 

09 Finger pose control With the 

fingers now following the rest of the 

rig, let’s look at creating some controls to allow 

the animator to pose the fingers quickly. For the 

control, use the CV Curve Tool and create a 

shape that mimics a hand’s silhouette. Rename 

this control ‘fingers_ctrl’. Translate and orient 

the control so that it sits close to the fingers, 

and scale it up if necessary. Once you are 

06
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08
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05 FK finger controls Now we’ll turn 

to the FK controls. We’ve supplied a 

very simple script that will go in and create the 

controls for any selected object that has a 

name ending with _jnt. If you’ve used a 

different naming convention throughout your 

rig, just modify the script (it’s pretty self-

explanatory where) to make it work. Now, 

open up the Script Editor and in a new Python 

tab, click Load Script. Navigate to the scripts 

directory of the supplied Maya project and load 

the create_finger_ctrls.py script. By using this 

script, we will create an additional group within 

each of the controls’ hierarchy structure (_

drive). This _drive will be used to drive the FK 

controls using the IK joints. By doing this on a 

level above the _sdk group, we will still be able 

to create a range of poses with the fingers that 

the animator can quickly hit. To run the script, 

select all the _bind_jnt (excluding _end_jnt), hit 

Cmd/Ctrl+A in the bottom half of the Script 

Editor and then hit Enter to Execute it. For each 

finger joint now, you should see a control. If 

they are hard to select, use Component mode 

to play with their shapes. One thing the script 

did not do, however, is create the parent-child 

relationship between each control to mimic the

FK hierarchy of our joint chain. We’ll have to do

05
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happy, parent it under fingers_ctrl_grp, and 

then with fingers_ctrl still selected, go to 

Modify>Freeze Transformations. In the 

Channel Box, highlight Translate, Rotate and 

Scale, and ‘Lock and Hide’ them using RMB. 

We now want to add some custom attributes 

that the animator can use to pose the fingers. 

With fingers_ctrl selected, go to Modify>Add 

Attribute and create the following: curl, 

scrunch, spread1, spread2, relax and claw, with 

the following settings: Data Type: Float, 

Minimum: -10, Maximum: 10 and Default: 0. 

You can also add additional attributes to drive 

each finger individually. 

10 Drive the poses with SDKs With 

the attributes ready, select all the finger 

controls (other than <finger>A_ctrl), and press 

Up twice. This will let you pick-walk up to the _

sdk level of each control (which is what we will 

use to drive the finger attributes). Alternatively, 

go into Outliner and select all the _sdk groups 

for the finger controls. With the _sdk groups 

selected, go to Create>Quick Select Sets, and 

call it ‘finger_sdk_set’. This will let us come 

back and select the _sdk nodes if need be. 

With the _sdk nodes still selected, go to 

Key>Set Driven Key>Set. This should bring the 

selected groups into the Driven window. Select 

fingers_ctrl and hit Load Driver. The entire rig 

should be in default position and the finger_ctrl 

attributes should be at 0. Now, highlight Curl in 

the top-right box, all the _sdk_groups in the 

bottom-left box, Rotate Z in the bottom-right 

box and hit the Key button. Set the value of 

Curl to 10, use only the Rotate Z channel of the 

_sdk group nodes to curl the fingers and create 

a fist, and hit Key once more. Going between 0 

and 10 now with the Curl attribute should curl 

the fingers. Set Curl to -10, select all the _sdk 

group nodes, and use Rotate Z to go in the 

opposite direction and hit Key once more. Let’s 

move on to Scrunch next. In the top-right box 

of the SDK window, highlight Scrunch, and with 

the same settings (all the _sdk groups and 

Rotate Z highlighted), hit Key when everything 

is at 0. Then set the value of Scrunch to 10, and 

use only the Rotate Z channel to create a pose 

of someone scraping their fingers against a 

blackboard. Hit Key when you are happy, and 

do the opposite at -10. Using this method, 

create poses for the remaining attributes on 

fingers_ctrl. You’ll find that sometimes, you’ll 

need to use a different Rotate attribute. For 

example, for the Spread attributes we have 

used Rotate Y. 

11 Finalise the rig Start by adding a new 

attribute to fkIk_vis_switch_ctrl and then 

call it ‘ikFingers_vis’. Give it a Min of 0 and a 

Max of 1. Then use Set Driven Keys and use 

this new attribute to drive the Visibility on 

fingers_ik_ctrl_grp. This should help keep the 

viewport a little cleaner. In the Outliner now, 

select all the finger control groups and hit 

Cmd/Ctrl+G. Rename this group ‘fingers_

ctrl_grp’. Then take all the groups holding the 

finger joints, group them together and call this 

group ‘fingers_rig_grp’. Take both of these 

groups and parent them under global_SRT_

ctrl. Next, create one more control that will let 

you translate the entire arm in either FK or IK 

mode. In the Top view, just use the CV Curve 

Tool to create an arrow shape (or a shape of 

your choice). Then name this shape ‘arm_

main_ctrl’ and hit Cmd/Ctrl+G twice to 

create two group nodes above the new 

control. Rename the two group nodes 

appropriately with the _sdk and _offset 

suffixes. Now take the _offset node, hold 

down the V key on the keyboard (for point 

snapping) and snap the control to wrist_

bind_jnt. If you cannot select the control 

easily as it is penetrating the mesh, edit its 

shape in Component mode. Parent the 

following groups under arm_main_ctrl: 

arm_fk_ctrl_grp and arm_ik_grp. The latter 

group should be housing elbow_ik_ctrl_

offset, arm_ik_ctrl_offset and arm_root_ik_

ctrl_offset. Then take arm_main_ctrl_offset 

and parent it under global_SRT_ctrl. Test the 

arm to see if it all works correctly, and if so, go 

in and pop all the relevant parts into the 

relevant Display Layers. ‘Lock and Hide’ any 

attributes you do not want the animator to 

key, and hide anything important (such as the 

IK handles) to finish the rig. The rig should 

now be complete and you can now skin the 

geometry to the joints.

Get in touch for answers 
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I
n this tutorial we will go over some of the most important, 

useful techniques for designing a new tank from scratch. 

This tutorial is meant for artists with some advanced 

knowledge about shape and design. We won’t cover 

modelling skills and tricks, as that’s something you can learn 

on your own in other tutorials.

The goal of this tutorial is to give people an overall view of 

how to tackle a big piece like this without getting lost in the 

overall view of the vehicle. Next to that you will see us using 

some dioramas for reference. 

Anybody can go to a store and buy a vehicle assembly box, 

but making it stand out is something diff erent, so keep an eye 

on such a piece. These model kits are also very handy for 

reading references from as they put a lot of eff ort in making 

these look as close as possible to the original designs, plus 

you can look at any part from any direction you want. We 

hope that by the end of this guide you, as a reader, will search 

more widely for reference, because at the end of it all, that’s 

the part of the process that makes your design interesting, 

functional and believable. We tend to use the same websites 

for reference: primeportal.net and home.comcast.net/

bzee1b/home.html. 

For this tutorial we used 3ds Max for the high poly, together 

with ZBrush and MODO for the low poly (we switched to this 

one for the Booleans and unwrapping tools). The model itself 

is rendered in 3ds Max.

01 Gather references The most important step of the 

whole process is gathering and using references. For this 

tank we just started searching for two tanks that have some 

uniqueness to them. We went for two extreme versions: a 

WW2 British tank and a modern Iranian tank – the Sherman 

and the Nagmachon tank. It’s important to pinpoint what makes 

these designs interesting. For the Nagmachon it’s the side 

protection and the blocky feeling, while for the Sherman it’s the 

feeling of height the tank gives you combined with the the 

smooth shapes. A good thing to do next is to search for other 

designs/tanks that uses the same functions, design or 

silhouettes. For the Nagmachon we see that the tracks 

disappear into the same heavy protection, so we searched for 

something similar but with an older look like the Churchill tank. 

Next to that we used a lot of detailed parts from the Nakpadon.

The nice thing about Sherman is that fact that there are a lot of 

diff erent silhouette versions, so combining it is really easy. If you 

don’t know Maschinen Kriegers, look it up. Maschinen Kriegers 

are great if you get how they work. The art style is all about 

smoothness and no cliché shapes. And that’s something we try 

to do when we design the big shapes for the tank. Hard surface 

doesn’t mean everything has to look hard – smooth shapes 

(with enough control) give your audience some more breathing 

room and more space to rest their eyes. There aren’t many 

Maschinen Krieger models out there and that’s good – that way 

you can use your own imagination for the designs.
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02 Build parts and weld the seams 
It’s never a good thing to only go for 

one surface type, it’s just not interesting. The 

nice thing about organic pieces like cloths and 

bags is the wide range of colours. In this case 

we went for some backpacks. Now, the tower 

may be the biggest eye catcher. The shape/

design idea comes from the unique Lun-class 

Ekranoplan. We think that every tank should 

have a hatch so we start from the top, add 

wings, and combine Maschinen Kriegers 

shapes with original ideas from the Ekranoplan. 

To make it feel more dangerous we add side 

guns and rear guns. The machine guns are 

situated underneath the turbines so they would 

not end up in the turbines. Next to that we add 

a lot of pipes and exhaust pipes to give it that 

heavy industrial feeling. In the image you can 

see some key pieces we pay close attention to 

when designing the tower. Welding can add a 

lot of believability to your model, it’s so much 

better than just shoving faces into each other.

And if you look at tanks you can see how they 

are sand-casted. It’s important to pay close 

attention to references and see how things are 

sand-casted, and try to mimic that.

03 
Non-symmetrical designs 
Building up the base of your vehicle 

with symmetry is a good thing, but you have to 

keep in mind where you will break up the 

symmetry afterwards. Another way of 

breaking it up is by adding more details to it, 

but they have to be details that make sense. 

For example we added some extra cables 

running over the complete model. When 

designing a vehicle, remember it doesn’t have 

to work, it just has to look like it could work. If 

you look at the tower you believe this works, 

just because of all the exhaust pipes and caps. 

If this tower was completely fl at nobody would 

have believed that it works. To make the overall 

shape more interesting we add more colours to 

the model, it’s something that’s used in real 

vehicles as well, but of course, with a purpose. 

Most of the time, pieces that crew members 

interact with are painted in a bright colour, 

mostly red, so we did something similar. 

04 Add details and bevels A lot of 

details can make your low poly so 

much easier. In this phase we just try to search 

for pieces that would take forever to make a 

low-poly bake out of them and try to fi ll up 

these areas with other details, like pipes, so that 

they form solid shapes. That way you only have 

to model the overall silhouette of all assembled 

details and bake it totally fl at. For that extra 

believable touch to your mechanical 

masterpiece, add fl oaters to be placed against 

your model to fake details. To make them 

blend, it’s good to scale them out a bit (with the 

Shift key and Scale X and Y) with a blue colour. 

You can do the same for little seams, you copy 

face out, bevel those out and put them against 

the model again so that they blend perfectly 

with the base model. Once we are happy, we 

will start adding props to the model, in this 

case add a lot of diff erent petrol tanks and a 

jerry can and it’s good to vary these to break up 

the repetition a lot more. We always make sure 

we have four diff erent versions of the same 

props, that way it never feels like we are using 

the same props over and over again. On the 

Beetle you can see how four organic pieces 

break up the roof. We just bent and squeezed 

some of the rolled-up cloth to make it look 

interesting. This Beetle is also a good example 

of how hard-surface shapes can be smooth.
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05Tweak and try a low-poly pass 
You probably want to add something 

extra to your model. In terms of decals, we 

always model and render them separately 

because decals in 3ds Max or KeyShot cast 

shadows, so you will want to cancel these out. 

This is something you won’t have in MODO. 

At the end, paint some extra cast shadows to 

make sure they blend in correctly. Just don’t 

forget that all the decals that are backfacing 

should be deleted, otherwise you will end up 

with strange results. Next it’s always nice to 

tweak levels from your picture separately. Try 

to match the low-poly model as close as 

possible to the subdivision model. If you fi nd 

some difficult parts, it’s best to leave those for 

now and mark those with a different colour 

(red), so we won’t forget them. Same for the 

pieces that we already have, those also have a 

different colour (green). The idea is simple, you 

search for these silhouettes and fill them up 

with more details so you can have a simple 

shape for low poly and for baking. When the 

easy parts are done we do another pass on the 

subdivision model with all the annoying/red 

parts of the model. We just add more 

additional details/shapes to the high poly so 

we can identify an easier and cheaper 

silhouette for the low poly. You will now want 

to preserve the illusion of depth without 

sacrificing too many triangles to get a decent 

and cheap bake. Let’s take the guns as an 

example; there are a lot of details in there, so 

make sure that you are able to bake it into easy 

shapes. We could fill up some more holes (red 

pieces) to make this process even easier.

06Check the wireframe and bake 
A good way to have a straight style 

through your whole model is checking the 

wireframe thickness. You want to make sure 

that everything has basically the same 

thickness. The tricount should go hand in hand 

with the size of the model. In our image, the 

blue pieces show a thicker wireframe than all 

the rest, so this has to be reduced way more. 

Splines can be really expensive. A good idea is 

to wrap cables together, so the low-poly model 

can be one cable but a really thick one. That 

way you bake multiple cables by just using one 

mesh. For example: if you have five cables, take 

the middle one and add a shell modifi er – this 

way you can have the more normal position for 

all of the cables. To make this method less 

noticeable, it’s a good idea to add one more 

loose cable around the other ones to make it 

more believable. Adding different colours can 

enpower this effect. The nice thing about Max 

is the stack – it benefits you in that you never 

have to translate your editable splines directly 

to editable poly. Instead you should use an 

editable poly modifer, that way, when you 

come back to the low poly you can change the 

interpolation and the sides. This just spares a 

lot of time and makes tweaking so much easier.

Make sure that you always check the ‘Generate 

Mapping Coordinates’ option. 

07 
Welding and exploding When we 

make a vehicle we try to weld 

everything together, so we don’t end up with 

50 elements – the less UVs the better. Welding

shapes can sometimes can sometimes be a 

pain. To solve this you can use Booleans. We 

prefer using MODO’s Booleans scene 

functions because they always work perfectly 

(as long as both meshes are completely 

closed). Welding all possible meshes together 

gives you better bakes. It takes more time but it 

gives you much nicer results and of course if 

makes it easier to work with afterwards. Be 

aware though: Booleans will always give you a 

dirty wireframe mesh with unnecessary 

vertices, but those you can easily target weld. 

The exploding process during baking can take 

up quite some time, and the only thing you can

do is make small off sets, between the high poly

and the low poly and you don’t want that. So 

make sure that you just play safe from the start. 

Take your high poly and make an incremented 

save. Open it and explode your high-poly 

model completely. Make another incremented 

save of it. Open that one, and start optimising it 

completely. Now, when you are are done with 

the low poly, you only have to merge in the 

exploded high poly and you are ready to set up 

your cage and bake your model. This is so 

much easier then having to explode both the 

low-poly model and the high-poly model, and 

this way you are sure everything has a 

matching off set.

All tutorial fi les can be downloaded from: fi lesilo.co.uk/3dartist
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Blockouts versus details
We always start working on a really interesting area of a 

vehicle/detailed part fi rst – that way you’re excited to 

keep working on it and you can fi gure out the style you’re 

going for. We will make this as Alpha as possible and we 

then bring the design to the team, showing them our 

vision of the vehicle, instead of having to say: ‘This is just 

a blockout, just imagine details being in there’. We don’t 

add a lot of bolts and certainly no splines/cables at this 

point. That’s something we do when we are completely 

done with everything.
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08 
Unwrap and test render We 

always start unwrapping pieces by 

testing out all kinds of projections – some of 

these provide such a nice result without having 

to do anything manually. It’s also important to 

know that relaxing pieces is super handy. You 

should relax every piece of your unwrap. We 

recommend you use MODO unwrap as it has 

a lot of useable features – it shows overlapping 

faces in red, deformation scale in colours and it 

has useful projection tools (like barycentric and 

so on). And if you really want to be lazy you 

can just planar unwrap all sides separately 

(with left, right, top, bottom, back and front) 

relax, or use barycentric projection on those 

and then stitch them together. It can be useful 

to combine projections as well as using the 

stitching and relaxing tool. Let’s take the 

reserve wheel of the tanks as an example, as 

it’s a more ‘complicated’ shape. We’ll start by 

doing test bakes. The resolution is really 

important here, because that’s how you know 

how far you can push the details and how 

much will get transferred into the fi nal Normal 

map. Never go crazy with details that won’t be 

tranferred into the bakes. It’s better to have a 

clean Normal map with readable details than 

an overdetailed bake that will just look way too 

noisy. When doing the test bakes, don’t make 

the render setting/quality too high. We don’t 

even bother setting up the correct smoothing 

groups for the model – we just want to get an 

overall view of what the bake will look like. 

Instead of doing a Normal map test bake, we 

bake Object space bakes, so see if the cage 

and the bake itself works. OBJ space maps 

don’t take long to render. The body is 8K and 

rendering out the OBJ took 30 seconds so it 

was easy to try diff erent things out. In the 

top-left image you can see a standard OBJ 

map from a vehicle.

09 
Bleeding masks and padding 
Rendering out masks are super 

important for big objects/vehicles. You assign 

colours/materials to the subdivision material 

for every material that you have in that vehicle, 

that way it’s easier to select pieces and paint 

them in. But this is something that could be 

diffi  cult with the blended edges. If the edges 

blend between two colours it will create a 

separate colour in between, and that’s never a 

good thing. That’s something you don’t have in 

Max. MODO is really precise for this, it never 

gives you colour bleeding. But if you want to 

use Max, it’s important that you use a a very 

wide colour palette with a lot of contrast 

between all the colours. Padding is something 

that’s really noticeable, but what is it? Well, we 

bake certain pixels further then the actual UV 

border, and that’s good. Otherwise you would 

sometimes see small seams in your model. It 

won’t hurt to add padding to all baked maps 

too, and this is certainly the case for masks, 

Normal Map and AO. In the images on the left 

you will see some extreme padding, but notice 

that it stops when it hits another colour.

10 
Texture and style the model 
What could be really handy for people 

that don’t have a lot of experience with spec is 

to just start with an Albedo map. Then load 

that map in Marmoset and just play with the 

slider of the spec or gloss input until you’re 

happy with the result. Read off  the value that 

fi ts with those sliders. For example: if the slider 

says 30 per cent, then you just divide 255 by 3 

and then you’ll know the colour value. This is a 

really good way for people who have problems 

with material defi nition. We render a lot of 

extra maps out for this model: some 

curvatures, light maps, global illumination, dirt 

and scratch maps for example. All of these are 

of course based on the high-poly model. Then 

we just made some texture styles. This way we 

got our own texture libary without having to 

switch to dDo to get some presets. From that 

point onwards we can easily texture models. 

Afterwards we tweak the mask and add colour 

variation. Make sure the texture’s not too noisy 

by using a base colour followed by just one to 

three layers of weather eff ects. In most cases 

just one main and one secondary, with slight 

hue shifts, and a third/fourth for decals will do.
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Kitbashing
It’s really handy to have some sort of 

kitbash kit with you, and you can get one 

by modelling useful pieces. Remember 

that the parts just have to look like it 

could work. Random machinery also 

helps speed up the process – it’s good to 

add those in places where your models 

lacks detail. We may also fi nd interesting 

shapes on the internet that we want in 

there. These pieces should not be too 

noisy. Vehicles are almost always made 

out of the same material, so make sure 

these pieces are the same material.

Get in touch for answers 
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W
hen creating the crystal turtle project, we knew 

that the crystals on its back would be the 

centrepiece of the image, so creating a realistic 

glowing crystal was essential to the success of this project. In 

this tutorial we will guide you through the steps it took to 

creating these crystals.

As with any 3D asset, the fi rst step is modelling. We’ll start 

by taking a look at how to use the Bisect tool to transform a 

sphere into a crystal model in just a few clicks. However, 

modelling won’t be the main focus of this tutorial. What really 

makes these crystals convincing is how the material is set up, 

which will be the real meat of this tutorial.

We’ll begin by covering the node setup and looking at the 

crystal’s surface shader. By combining diff erent coloured glass

shaders, we can simulate how a prism splits light. Then we’ll 

move on to volumetrics, which is split into three diff erent 

steps. The fi rst step is to give the crystal a vertical gradient, 

so that it’s opaque towards the bottom and translucent 

towards the top. The next step is to add some speckled 

details using procedural textures. The last step is to use a 2D 

image texture and transform it into a 3D volumetric texture 

for even more detail on the insides of the crystals. Lastly we’ll 

discuss how we did the surface displacement to add yet 

another level of realism.

01 Model the crystals We modelled the crystals using 

the Bisect tool, which cuts planar faces off  the side of a 

model. By default, there is no shortcut hotkey for this tool, but 

you can create one or search for ‘Bisect’ in the spacebar search 

menu. Starting from a UV sphere, use BIsect to cut away faces 

from the object until there are no curved surfaces left. In Edit 

mode select everything, search for Bisect, then click and drag a 

line through your object. Anything outside of that line will be cut 

away. Make sure to check Fill in the tool panel so that the 

cut-away plane gets fi lled in. If you fi nd that BIsect is removing 

parts you want to keep, drag the line in the opposite direction 

and it will remove the other side instead. If it doesn’t seem to be 

working, apply rotation and scale in Object mode. 

Model and texture 
crystals in Blender

BLENDER
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02 Surface material The key to this 

part of the shader is light dispersion. 

We want our crystals to split light like a prism 

does. To do this, add three glass shaders: one 

completely red, one completely green and one 

completely blue. Give each of these nodes a 

slightly diff erent IOR value so that it bends light 

a little diff erently. Combine the diff erent 

coloured glasses with two Add Shader nodes 

for a white glass that splits colours like a prism. 

You’ll see that we’ve merged this set of nodes 

into a single group called ‘Glass’ in our node 

setup. You’ll also see that our node setup 

replaces shadow rays with transparency. This 

isn’t physically accurate, but we do this 

because we don’t want the shell of the crystal 

casting a shadow on the inner volumetric 

details that we’ll be adding later. Not only does 

this speed up render times and reduce noise, 

but it also helps make the details easier to see. 

Also note: whenever working on a shader that 

refl ects or refracts light, it’s always a good idea 

to use an environment HDRI.

03 
Volumetric vertical gradient 
When looking at references, we 

noticed a lot of crystals were more opaque 

towards the bottom and more transparent 

towards the top. We can reproduce this look 

with volumetric textures. Using generated 

texture coordinates, add a Gradient Texture 

node. Then modify its direction and falloff  

using a ColorRamp node. You can hook this up 

to the Strength socket of an Emission node, 

and add that to the Volume socket of our 

material output. This looks a bit too uniform, so 

add some Noise Texture nodes and multiply 

their output with the gradient texture. When 

working on the volumetrics replace our Glass 

Shader node setup with a simple temporary 

transparent shader for faster render times. 

 04 Volumetric specs We can add 

some irregularity and visual interest 

to our crystals with more noise texture nodes. 

Add a Noise Texture node and run it through a 

ColorRamp node with a Constant falloff  for a 

hard edge. For more variety, we duplicated the 

Noise Texture and ColorRamp nodes and gave 

the second set a slightly diff erent scale and 

ColorRamp falloff . After combining these two 

noise textures with the Add node, plug this 

output into the Density socket of a Volume 

Scatter node. This can be combined with our 

vertical gradient using the Add Shader. 

05 
Volumetric image texture This is 

the fi nal layer of detail for our 

volumetrics. Since there aren’t many options 

for procedural textures in cycles, we tried using 

a grunge image texture. As our image is only 

2D and we want to map it to a 3D volumetric 

space, we split up the texture coordinate into 

three diff erent vector mapping nodes – each 

with a 90-degree rotation along a diff erent 

axis. Then the transformed texture coordinate 

is plugged into our image texture, and 

combined back together with the Add node. 

We can multiply the output of our textures 

with a Voroni texture to break up uniformity 

from our input image. Plug the output of this 

into a Volume Scatter node and combine it 

with the other volumetrics using Add Shader.

06 
Surface displacement The last 

step in making these crystals look 

realistic is to add some surface detail. Here we 

can just use the generated texture coordinates 

with a grunge image texture and a noise 

texture, then combine the two with a 

colour-mixing node. When experimenting, we 

found we could combine this Bump map with 

the volumetric image textures from before – 

giving us an even better-looking output. While 

working on the surface displacement; it’s a 

good idea to use a simple glossy shader for the 

material surface. This should make it easier to 

see the surface details you’re working on.

02

03

04

05

06

More glow and reducing noise
In our case, the glow we added with the volumetrics 

wasn’t enough. You can add more glow by adding a 

lamp inside the crystal but this can introduce a lot of 

noise to our renders. To reduce the noise without 

having to increase the number of samples, locate the 

Sampling panel in the Render options, change Clamp 

Direct to a value of 4, and Clamp Indirect to a value of 1.

Get in touch for answers 
to your technical quandaries 3dartist@imagine-publishing.co.uk @3DArtist            www.3dartistonline.comfacebook.com/3DArtistMagazine

All tutorial fi les can be downloaded from: fi lesilo.co.uk/3dartist 73



L
ighting, in its broadest sense, can make or break a scene 

– it is often one of the most overlooked aspects of 3D 

and will dictate how believable and captivating your 

scene will be. And this is also one of the primary reasons why 

some artists will dedicate their 3D career to understanding 

and deconstructing it. And with the advent of the Cycles 

rendering engine for Blender, lighting has never been so fun 

and intuitive. With that said, there are a few basic principles 

and rules to follow to create and complement convincing 

imagery, which will also give you more room to break these 

and experiment. The question of what type of lighting is best 

comes up often. As much as we would like to give a defi nitive 

answer to this, it all depends on what scene you currently 

have and what emotion you are trying to portray. It also goes 

hand in hand with the other aspects of your scene and should, 

in most cases, exaggerate and give more meaning to them. A 

very rudimentary example of this is when you have gone all 

the way in creating a very detailed model that has very 

convincing and realistic textures applied to it; however, during 

the lighting stage, you decided not to give much emphasis to 

it and just dropped in a few lamps here and there. After a 

while, you realise your scene isn’t looking as good as you had 

hoped it would be, despite your eff orts of adding all the 

necessary modelling and texturing details. Disappointed, you 

decide to abandon the project and swear to never fi nish it. In 

this brief guide, we’ll touch on the fundamentals of lighting 

and how you can incorporate them into your scene and avoid 

caveats that may demotivate you.

01 Basic scene setup For this guide, we will be utilising a 

very basic scene setup: a sphere and a backdrop. This is 

most useful when gauging your lighting scheme and will serve 

as a great reference later on when attempting larger and more 

complex scenes. Add a UV Sphere with the default settings, add 

a Subsurf Modifi er level 2, and set the shading to Smooth. For 

the backdrop, add a Plane with a Subsurf Modifi er level 3, then 

extrude the back part, as seen in the image below. Next, place 

your camera in front of the sphere so you can clearly visualise 

the whole scene.

Set up a lighting rig in Blender

BLENDER, CYCLES

01
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02 Material and shader setup In the 

meantime, we won’t be using any 

fancy materials and textures, just so you can 

clearly absorb the idea and not get distracted 

by other prevailing elements. Add a grey (RGB 

= 0.5) Diff use material to the sphere and 

backdrop. You can either use the Properties 

Editor or the Material Node Editor when adding 

materials to an object, the latter providing you 

with more control over the nodes as needed. 

At this point, make sure you have the Cycles 

render selected as the scene’s renderer.

03 
Key lighting setup In the following 

steps, we’ll gradually build a lighting 

setup that is most commonly used in 

photography studios and product 

visualisations. The key light serves as the 

primary source of light in your scene. Its 

purposes include (but are not limited to) the 

following: highlighting/emphasising the main 

subject, providing the initial shape and adding 

the main shadow. Add a Sun Lamp, position it 

at an approximately 45-degree angle (Top 

View and Front View). Reduce the size to 

create sharper shadows and use a relatively 

higher lamp strength than the default value.

 04 Fill lighting setup The fi ll light is 

used to add illumination to the unlit 

portions of your subject and to even out the 

shading. Usually, in photography studios, they 

use a softbox – a type of modifi er that scatters 

and softens the light shot from a strobe or 

fl ash. In most 3D applications, we can replicate

this by creating an object that will emit light.

In Blender, add a Plane, position it adjacent to 

the Sun Lamp but on the opposite side of the 

sphere, scale it to a relatively large size, and add 

an Emission shader to it, increasing the 

strength as needed. You’ll now notice that it 

killed the dark shading that we previously had, 

as well as adding a soft shadow opposite the 

emitter’s location.

05 
Back lighting setup As you may 

have already noticed, this completes 

the three-point lighting setup. This type of 

lighting is a cliché to artists, however, it serves 

its purpose well and lives up to its reputation 

too. Used sparingly, these lights will give life to 

your scenes that you would never have 

achieved otherwise. The back light, or rim light, 

is used to add defi nition to the overall shape 

and silhouette of the subject. When used on 

character portraits, it creates this wonderful 

scattering eff ect that is most noticeable on the 

hair strands and on skin. Add a Sun Lamp in 

Blender, position it opposite the key Light or the

fi ll Light, and adjust the strength accordingly. 

Depending on your scene setup, you also may 

want to create another back light to 

compensate the other side of your model, as 

well as disabling the shadows being cast from 

these light sources.

02

03

04

05

Lamp size matters
As with real life and in physics, the size of your light 

source dictates how sharp or soft your shadows are. 

The smaller your light source, the sharper and more 

defi ned your shadows will be. The larger your light 

source, the softer and more distributed your shadows 

will be. Keep this in mind when adding mood and 

adding drama to your scenes.
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06 
Ambient lighting setup The 

primary purpose of ambient light is to 

simulate the illumination that we receive from 

the sky, for example, on a cloudy and overcast 

day. When used alongside a CG and live action 

composite, this can help blend the CG scene 

seamlessly with real-life footage. Blender 

doesn’t have an explicit way of achieving GI 

(global illumination), but by adjusting the 

World’s settings, the results are almost 

convincingly similar. You can use this technique 

in conjunction with the key light method, but a 

better option is available on the next step. 

07 
Image-based lighting (IBL) One 

of the reasons we use HDRIs is 

because they have a higher bit-depth and can 

store additional lighting information that can 

dictate how your scene will be illuminated 

based on the image’s light intensity values. This 

technique is often used by animation studios 

worldwide to give more life to their scenes as 

well as seamlessly blend several elements 

together (ie by shooting a panoramic HDR of 

the set). In Blender, you can do this by adding 

an Environment Texture and adjusting the 

strength accordingly.

08 
Image-based lighting controller 
With the setup as seen in Step 7, we 

can further control how the lighting behaves by 

adding a couple of nodes in Blender that will 

enable us to rotate the environment texture, 

control the light intensity, control the light fi ll 

and adjust how much refl ection it casts on 

refl ective materials and objects. For the 

purposes of illustration, we’ve added two 

refl ective (metal and dielectric) objects. 

However, there are still a lot of possibilities with 

IBL in Blender and we are only touching the 

surface with this tutorial. 

 

09 Volumetric lighting setup And to 

conclude this brief overview to 

lighting, we’ll introduce you to one of Blender 

and Cycles’ new features. Volumetric lighting 

simulates situations which include fog, god 

rays, dust particles and the like. To achieve this 

in Blender, simply attach a Volume Scatter 

node into the World Output node’s Volume 

Input, using a Spot Lamp as the primary source 

of light. By default, volumetric rendering in 

Blender is relatively slow, however, there are a 

few tricks to work around this with little or no 

detriment to quality.

Get in touch for answers
to your technical quandaries 3dartist@imagine-publishing.co.uk @3DArtist            www.3dartistonline.comfacebook.com/3DArtistMagazine

All tutorial fi les can be downloaded from: fi lesilo.co.uk/3dartist
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Chillblast 
Fusion 
Projection 3

T
here are plenty of reasons to buy a 

custom-built workstation from a reliable, 

well-established independent UK vendor. As 

we’ve seen recently with workstations from 

Overclockers and Scan Computers, you’ll get great 

rendering performance from a 3D system put 

together and overclocked by hardware enthusiasts, 

made from some of the best performing 

components on the market.

Chillblast is the latest such vendor to join this 

elite list with a desktop workstation called the 

Fusion Projection 3, that fi ts within a relatively 

modest budget.

It has managed this by slightly cutting a few 

areas to shave a good few hundred pounds from 

the price, and that’s without seriously 

compromising performance.

For example, in the default confi guration at least, 

you get a heavily overclocked Intel Core i5 

processor rather than a Core i7. The big technical 

diff erence between them is hyper-threading in the 

Core i7, so Windows sees a quad-core chip as eight 

logical cores. It’s still only quad-core at its heart 

though, so in many tasks it won’t perform any 

diff erently to a Core i5.

The other diff erence is slightly higher clock 

speeds, but since the Core i5-4690K has been 

overclocked from 3.5GHz to 4.2GHz, this isn’t 

really a factor.

With it is an Nvidia Quadro K2200, a workhorse 

mid-range GPU, that’s a no-brainer for an 

aff ordable but capable 3D workstation such as this.

There’s also 16GB of DDR3 memory, an ASUS 

Z79-K motherboard, a 128GB Samsung SSD and a 

1TB hard disk, all put together in a very sleek and 

roomy Fractal Design Defi ne R5 chassis and 

powered by a 600W Corsair power supply. The 

build quality is top-notch too, with a great job done 

on cable management and internal design. 

Sure, if you were hoping to produce something 

with more detail than the average Pixar movie, you 

might require more heavy-duty hardware, but this 

specifi cation (and price) is just right for students, 

3D beginners or anyone looking to test the water 

with 3D animation.

The SSD is a high-performance Samsung SM951 

PCI-Express model, slotted into the motherboard’s 

M2 slot. It runs a heck of a lot faster than a typical 

SATA SSD, with impressive read speeds of 725 

MB/sec and write speeds of 646 MB/sec. 

We can’t complain about the speed, but 128GB 

is a paltry size these days. Luckily though, a boost 

to 256GB only costs £50 extra on the 

customisation page.

In our tests the CPU benchmarks look excellent 

for a workstation costing £1,279, while the GPU 

results are in line with other workstations that use a 

Quadro K2200.

In CINEBENCH it scored 651, a fi gure that’s 

lower than it would be if the CPU supported 

hyper-threading, but only by a slim margin. In 3ds 

Max the 1080p demo scene took 15 minutes 43 

seconds to render, it’s not at all bad and closely 

matches the pricier quad-core Xeon E5 chips we’ve 

seen, and indicating performance that’s well suited 

for rendering tasks of average complexity.

How does it compare to other similar 3D 

systems? HP’s £2,700 Z440 uses the same GPU, 

but off ers better CPU performance, with a 

quad-core hyper-threaded Xeon E5-1630 v3, 16GB 

ABOVE The black Fractal Design Defi ne R5 is 
a decent case with a sleek design

A capable and aff ordable desktop 
3D workstation that marks a good 
starting point for 3D work

 CHILLBLAST FUSION PROJECTION 3
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BELOW The cable management and internals are all kept tidy 
and well presented

ABOVE The mid-range Quadro K2200 is great for this 
aff ordable workstation

ABOVE Replacing the side panel was slightly
fiddly after we’d finished poking around inside

ABOVE An Akasa Nero 3 is an effi  cient but 
inexpensive air cooler, and keeps the Fusion 
Projection 3 running almost silent whilst in use

 The build quality is top-
notch too, with a great job

done on cable management
and internal design  

Verdict

Summary

Great value and a well-planned confi guration means 

the Fusion Projection 3 will work well for small-to-

medium sized projects

Price   £1,279 (inc VAT)

Website  chillblast.com

CPU  Intel Core i5-4690K (clocked to 4.2 GHz)

RAM  16GB DDR3

SSD  128GB Samsung SM951 PCI Express

GPU  Nvidia Quadro K2200

HDD  1TB

Essential info

Features

Performance

Design

Value for money

of ECC DDR4 memory and an X99 motherboard 

rather than a Core i5.

The Fusion Projection 3’s CPU benchmark result 

is slightly lower, but has a higher GPU result of 

122.6FPS. In SPECviewperf, results are slightly 

ahead with 47.2 in the catia-04 section, eight 

points ahead. Most importantly, it does all of this at 

half the cost.

There’s also a typical choice of storage, graphics 

and processor upgrades that are all available from 

the company’s website should you need more 

performance. Although currently, the only available 

GPU upgrade is a Quadro K4000 rather than 

Nvidia’s newer K4200, and no AMD cards are 

off ered to us here. The lack of GPU variety here is a 

slight Achilles heel in what is otherwise a strong 

off ering indeed, especially since the Fusion 

Projection 3 comes with a decent fi ve-year 

warranty and two-year collect and return.

Orestis Bastounis
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Wacom Cintiq 
27QHD

A
s far as graphics tablets go, Wacom’s newly 

introduced Cintiq 27QHD is defi nitely the 

peak. For one, it looks fantastic – it’s almost 

impossible to be in the same room as this piece of 

tech without feeling a compulsive need to try it.

This is in part due to how impressively crisp 

every artistic detail looks on screen. The 27QHD 

off ers the highest resolution of any Cintiq at 2560 x 

1440: a widescreen 16:9 with four times the pixel 

density as a standard HDTV. Colour management 

has defi nitely not been forgotten either. The 

27QHD features 97% Adobe RGB, 1.07 billion 

colours and Rec. 709 for colour-sensitive 

workfl ows. Colour calibration can be improved 

upon even more with the separately sold Wacom 

Color Manager, with calibration so precise that 

there’s no need for a separate reference monitor. 

Despite having used it with Sculptris, Rebelle and 

Photoshop over several hours, the Cintiq 27QHD 

also stayed cool, and the antiglare on the screen 

worked very well.

Any users familiar with Wacom’s older Cintiqs 

will also be pleased with the gadgets that come 

with the 27QHD. The Cintiq 27QHD Pro Pen 

boasts 2,048 levels of pressure sensitivity with a 

40-degree pen tilt recognition that Wacom users 

expect. Along with this, it features a pressure-

sensitive eraser that works like a normal pencil’s 

eraser at the back, and two side switches that can 

be customised for common commands, such as 

the middle-mouse click and right-click that are 

useful when working in 3D software. 

The handiest gadget that comes with the 

27QHD for 3D artists, however, is probably the 

new ExpressKey Remote. A replacement for the 

ExpressKey buttons on the old display borders, the 

remote enables stress-free access to favourite 

shortcuts as well as zooming, rotation or tool-

changing functionalities. 

Best of all, the ExpressKey remote actually has a 

magnetic back so a user can place it wherever it’s 

most comfortable on the screen borders while 

working, making it much harder to lose. For an 

extra $500 (£316), artists can buy the 27QHD with 

touch functionality, which lets users work both 

remotely and hands-on with iPad-like multitouch 

gestures to zoom and rotate in the display. 

The 27-inch display is enormous and fairly heavy 

at 9kg on its own (and 25.1kg with the optional 

Wacom ergonomic stand), so it does require a lot 

of desk space, and it’s not so easy to reach around 

for access to the keyboard or mouse. As a tablet 

needed only for sculpting or sketching out concepts 

from time to time, then, it might not be the best 

choice – especially as it costs a whopping 

$2,299.99 (£1,799.99) and that’s without the 

added price of the multitouch version. If needed as 

a nonportable, permanent addition to a workfl ow 

and workstation, though, the 27QHD is worth it. 

Set-up time takes minutes due to the range of 

adaptors and cables included in the box and once 

it’s properly in use, it is really exciting to feel the pen 

work smoothly on the glass display, and to have so 

much screen real-estate to draw and sculpt on as 

well. If using a tool as interactive as a pen within 

software like ZBrush sounds like heaven, the 

Wacom Cintiq 27QHD is a graphics tablet that’s 

very hard to beat. 

Larissa Mori

ABOVE The edgeless glass display can go from a fi ve-degree 
slope to a 20-degree one using in-built foldout legs, so working 
on it is very comfortable

BELOW Due to the range of cables 
included, it only takes minutes to 
set a Wacom Cintiq 27QHD up

We test the best of the best with Wacom’s 
most high-end tablet

Industry experts put the latest workstations, 
software & 3D printers through their paces
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RIGHT The new ExpressKey Remote means 
you don’t have to worry about accidentally 

pressing any buttons again

LEFT The Cintiq
27QHD Touch
Pro Pen features
Wacom’s
proprietary Tip
Sensor
technology, which
offers users
near-zero (one
gram) starting
pressure

BELOW The Cintiq works with a variety of 
confi gurations including with another Cintiq, 
an Intuos pen tablet, or a pre-existing mouse

WACOM CINTIQ 27QHD  

 The 27QHD off ers the 
highest resolution of any Cintiq 
at 2560 x 1440: a widescreen

16:9 with four times the pixel
density of HDTV  

Verdict

Summary

The Cintiq 27QHD is today’s ultimate creative tablet – 

just be sure to have the desk space for it

Price   £1,799.99 / $2,299.99 

Website  wacom.com

System requirements  Windows 7 (32- and 64-bit) 

and 8 / Mac OS X 10.8 and up

Cables included DisplayPort, HDMI, USB 3.0, 

Micro USB (ExpressKey Remote)

Adaptors included DVI-D TO HDMI, 

Mini DisplayPort to DisplayPort

Size 770 x 465 x 54.5 mm / 30.3 x 18.3 x 2.1 in

Response rate  12ms

Essential info

Features

Performance

Design

Value for money
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Mixamo2.0
We take a look at Mixamo, the latest software that Adobe intends
to put into the cloud

 MIXAMO 2.0

W
ith the news that Adobe had acquired 

Mixamo at the beginning of June we 

were eager to see exactly what 

Mixamo could do. Rather than just a stand-alone 

software, Mixamo provides an online service to 

create, rig and animate game-ready characters, 

allowing you to then export the rigged mesh and 

any animations purchased for use in Unity 5, 

Unreal Engine 4 or any other engine that supports 

FBX or COLLADA files.

Having several low-poly meshes to hand we 

were instantly drawn to the Auto-Rigger feature, 

which accepts both OBJ and FBX files along with 

any associated materials. Once uploaded, the 

interface is clear and easy to understand; bone 

placement being handled by five markers, for chin, 

wrist, elbow, knee and groin. The documentation 

suggests a T-pose, but we were pleasantly 

surprised that it coped well with the A-pose that 

we loaded into the software – even the fingers 

were of an acceptable standard. 

There were skinning issues with the long coat 

and hood on the mesh, although these were 

expected, hence their inclusion. The viewer gives 

you a basic idle animation to check that you are 

happy with the results, enabling you to go back to 

the joint placement step of the process and adjust 

it if it’s necessary.

Once processed the mesh is stored in your 

account for later retrieval or editing. The feature 

that we feel may be missing the most in the 

process is the lack of an ability to tweak the 

skinning of the mesh by hand, a few bespoke 

adjustments would have made for a far better final 

result, but this can be accomplished after 

downloading them in a 3D software of your choice. 

It’s not a dealbreaker, but it is certainly something 

that would enhance the Mixamo toolset.

Mixamo has an extensive animation library for 

you to apply to your newly created rig. We were 

able to browse over 2,200 character animations, 

preview them on our mesh, and alter parameters 

such as pacing and arm width before saving them 

to an account ready for download. As we gather it,

the free version currently available allows for ten 

autorigged character downloads and 20 free 

animation downloads – it’s not enough to populate

a game, but more than sufficient for any character

artist to get some excellent presentation material 

for the portfolio.

In addition to the Auto-Rigger, Mixamo comes 

with Fuse, an out-of-the-box character 

customisation application which enables you to 

generate characters from a set of clothing assets 

and anatomy types/genders. Also in the package 

is an online LOD generator called Decimator 

Preview, however at the time of writing this, due to

the acquisition by Adobe it is only available to 

existing Indie and All Access customers.

Seth Nash 

Verdict

Summary

A great rigging solution for standalone characters and 

projects, especially while its free!

Price   Currently free, with limited access

Website  mixamo.com 

OS  Windows 7 and up / Mac OS X 10.8 and up

CPU  Dual core CPU or higher

RAM  4GB

Browser  WebGL enabled

Free space 3GB (for Fuse)

Minimum browser resolution  1920 x 1080

Essential info

Features

Performance

Design

Value for money

BELOW All of your uploaded meshes are stored in a 
single online repository for further adjustment and can 

be downloaded whenever you need them

Auto-Rigger’s interface is well designed and 
easy to use, allowing for both symmetrical and 

nonsymmetrical joint placement
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 The challenge with any 
optical motion-capture 

system is creating a 
camera setup that can
track the markers as

accurately as possible  



Humster3D was looking for 

atmosphere and a strong idea, as 

well as an absence of any glaring 

mistakes of physics or anatomy 

when it came to this recent 

Roman-themed challenge, but 

apart from that, entrants were free 

to render as they wished. The 

results were certainly varied! Here 

we get a quick look at how the 

winning entries were created.

Humster3D Ancient 
Rome challenge
The ancient world of Rome proved a fertile topic for the 3D community, and so we 
spoke to the winning entrants of Humster3D’s latest competition

The most interesting thing for RStyle was to balance the creation of two diff erent 
civilisations. “The ancient masters used the golden section a lot… I studied Italian 

paintings of the 15th Century, which are very impressive in terms of composition and light”

 COMMUNITY NEWS

Focus on the idea. Don’t 

be too serious about the 

work. Make a joke or 

something that is 

extraordinary about the 

topic of a competition. Do 

something unexpected. 

Here, the idea to add 

contemporary construction 

elements came only in the 

last few days.

With composition, pay a 

lot of attention to the main 

composition of the shot. I 

went through a ton of old 

paintings to fi nd the 

balance of the geometry 

and light. 

Work on the foreground. 

When you have many 

details in terms of textures 

and geometry in the 

foreground of the scene, 

the rest of your image will 

look very detailed too.

Make time for 

postproduction. Using 

things like colour 

correction and ZDepth 

pass can change the overall 

impression a lot.

FIRST PLACE 
Sergey Smereka (RStyle)
Restoration, 2015
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For Maciek, the one boring part was modelling the harness with details like stripes, buckles
and so on, “I also don’t feel very comfortable with characters, but this time it went quite
smoothly. Hair for the horses and helmet were done with Blender Hair Particle System”

www.3dartistonline.comGet in touch… @3DArtist Facebook.com/3DArtistMagazine

CGTrader 3D 
Sci-Fi challenge
Always popular, this CGTrader
competition is a great way to tackle

In this kind of project I

think the most important

thing is the idea, even more

than the technical quality of

the scene. But it must be well

executed. You need to keep

the main objects properly

illuminated and positioned,

trying to achieve a powerful

and eye-catching image no

matter how simple the scene.

As the characters are

cartoons, there’s no need for

realistic proportions or a

good amount of details, but

they must be expressive.

The point of view lets you

see lust and ambition clearly,

and the main light source is

low, giving the image a

dramatic feel.

I use Blender for almost all

3D tasks like modelling,

rigging, texturing and so on.

For rendering I used Maxwell

Render with B-Maxwell. I

thought the competition

would be a good opportunity

to learn Maxwell.

The hardest part for me

was to pose the horses and

to find a good angle for the

image. I did hundreds of tries

even when the modelling

was not completely finished.

I like to start lighting and

shading the scene even if the

modelling is not completely

finished. This helps me to

create and modify the

concept in my mind.

ut

aneRender.

What were the main challenges?
I set forward design challenges that would characterise 

this spaceship design; it needed to have a visible base 

frame with modular features (like a motorcycle) and a 

well-balanced distribution of shapes and details.

What do you do for a living?
I’m a freelance computer graphics artist and you can 

view some of my work at cgtrader.com/iterateCGI and 

on my website crea-zone.com too.

How did you assemble y
I used ZBrush to create t

models. The main challe

idea and the time I had t

them. I am a hobbyist an

two little children so I ha

just two to three hours in

the evening for my mode

How did it feel to win?
It’s a great honour and a

motivation. Now I see t

people like my work I wi

on and hopefully get bet

What do you like about
Sci-fi is great because

everything is possible. It

doesn’t matter which wa

wanna go, sci-fi is the w

can do it.

BEST MODEL WINNER 
Johan De Leenheer (IterateCGI)
Faucer Fuga-MX230E, 2015

BEST PORTFOLIO WINNER 
Dennis Jacobsen (Harlyk)
Sci-fi Trooper, 2015

SECOND PLACE 
Luis Lara Osorio
Conspiracy, 2015

THIRD PLACE 
Maciek Ptaszynski
Circus Maximus, 2015
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Luis Lara Osorio has been working on 3D projects since 2002, but it was not 
until last year when he and his friend Oriol Folch founded G24 Studio, a small 
studio specialised in 3D art. See g24studio.com for more
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A
dobe had already provided offi  cial Photoshop 

CC support for Mixamo – a service which lets 

users create, automatically rig and animate 

their characters online – last year, but now it seems 

the company has gone even further than before by 

buying Mixamo altogether.

“3D tools have come a long way in the past few 

years, but are still generally inaccessible to most 

designers due to the great expense and extensive 

training required to learn the complicated techniques,” 

said vice president of products, B Winston 

Hendrickson in an Adobe blog post announcing the 

acquisition. He continued with confi rmation that 

Mixamo’s technology will mean Photoshop is set to 

gain many more 3D features in the future. Through 

the integration, Photoshop users will be able to create, 

customise, rig and animate 3D content, as well as take 

advantage of tens of thousands of high-quality turnkey 

3D models, starting with stock characters that can be

easily pulled into projects. Adobe is expected to

implement more 3D design-led features in the fu

HAVE YOU HEARD? Rainmaker Animation Inc has begun production on a reboot of ReBoot, the world’s fi rst fully CG TV show

Adobe votes 
3D for CC
The company’s acquisition of Mixamo will bring 3D 
functionality to Photoshop like never before

Apple to leap 
forward with 
rendering

Learn the fundamental concepts of Metal at 
developer.apple.com/metal, or discover more 
about OS X El Capitan at apple.comLearn more about Adobe’s acquisition of Mixamo at blogs.

adobe.com/creativecloud/unlocking-the-power-of-3d-for-the-
creative-community

The fi rm potentially jumps 
ahead of Khronos Vulkan 
with Metal 
After fi rst introducing it as a feature for 

iOS 8 in 2014, Apple has announced at 

its WWDC 2015 conference that 

Metal, a core-level graphics technology 

which combines OpenCL and OpenGL 

into a unifi ed API, is now going to be 

fully integrated into the company’s 

upcoming OS X release, El Capitan.

Metal will make use of a new shading 

language that is based on C++11 and 

implemented via Clang and LLVM. It 

will deliver system-wide performance 

gains; games and pro apps will be able 

to tap into the full power of Mac 

graphics processors providing up to 50 

per cent potential reduction in 

system-level rendering.

This is amazing news for game 

developers, who now have access to a 

streamlined API, precompiled shaders, 

support for effi  cient multithreading to 

reduce CPU load and an improved 

battery life to take their games to a new 

level of performance. 

Metal is not just good news for 

games, though. The performance 

boost it gives can also make a big 

diff erence in other graphics-heavy 

software. During testing with After 

Eff ects, for example, Adobe announced 

a notable eight times improvement 

in rendering

Creative Cloud 2015
All of Adobe’s desktop and mobile apps are 

being updated with either new technology or 

new features in this year’s evolution of CC. 

Photoshop is getting Artboards, the Dehaze 

tool to add or remove haze from photos, Blur 

Gallery fi lters that can now match the grain in 

an image, faster repair tools, a Panoramic 

Content-Aware fi ll and more. 

Due to Adobe having acquired Fotolia for 

$800 million (£516 million) earlier this year, 

users will also be able to search through over 4 

million stock images straight from Photoshop.

Mixamo CEO Stefano Corazza 
founded Mixamo as a spin-off  from 

Stanford University’s BioMotion Lab

 INDUSTRY NEWS



The increasingly popular artist-led
festival has sold out, but can still be
watched via THU’s TV channel
The five-day festival for digital artists described as a

‘digital art rave’ has been getting more popular every

year, but now Trojan Horse Was a Unicorn

organisers have announced that even creatives who

don’t get to go to Portugal to attend the festival can

still participate through THU TV. A paid channel,

THU TV will broadcast the entire September event

24 hours a day for all five days.

“THU is moving from ‘The Little Engine That

Could’ to a full-blown community that incites

passion all around the world,” said Scott Ross, THU

ambassador and former CEO of Digital Domain.

“Artists fly in from all over just to be a part of it, and

this year, Trojan Horse Was a Unicorn is unveiling

even more ways to get involved.”

Along with keynote speakers Scott Ross and Craig

Mullins, speakers at the conference include Ian

McCaig, Alberto Mielgo, Shane Mahan and more,

with workshops and presentations to propel artists

to the next level.

The popular real-time architectural 
visualisation competition from 
Ronen Bekerman returns 
Anyone interested in creating photorealistic arch-vis 

or game environments could stand to win big money 

this summer, with over $60,000 (£39,000) in 

prizes including a $25,000 (£16,000) grand prize 

for group entrants and a $12,500 (£8,000) grand 

prize for individual entrants up for grabs in Ronen 

Bekerman’s sixth architectural-visualisation

challenge, The Vineyard.

Epic Games has been announced as the official

sponsor to the 2015 challenge, so competitors will

need to build their entries exclusively in the now free,

powerful Unreal Engine 4. Official submissions will

take place on a dedicated forum at ronenbekerman.

com, and Epic support is available at forums.

unrealengine.com. The challenge will run until the 15 

September, with winners announced at the State of 

Art Academy in Venice on the 2-3 October.
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Features are focused on speed
and simplicity with new lighting
presets and more
KeyShot 6 is set to be an exciting new update for

the physically correct rendering engine,

designed to improve workflow efficiency with

multilayer PSD output as well as a host of other

expanded features like real-time region

rendering and much more.

“As an avid KeyShot user since version 2,

I feel this is the next big step for this amazing

rendering program,” reported concept designer

Vitaly Bulgarov. ”The huge addition for me is the

Interior lighting mode. Even if you’re not

planning on doing architectural visualisation,

you’ll appreciate the interior optimisation for

those product shots where lifelike daylight with

graphics can cast shadows produced from the

surrounding environment if needed.”

DID YOU KNOW? All of Disney’s studio shorts will be released together for the fi rst time in August as a disc collection

Bringing you the lowdown on product updates and launches

Luxion unveils KeyShot 6

THU TV tickets
announced

Unreal Engine challenge launched

Software shorts
Non-Photorealistic 
Rendering 2 Kit
The Foundry’s latest kit for MODO 

801 and 901 lets users easily create a 

range of hand-drawn looks when rendering, 

resulting in stylised, expressive results that suggest 

traditional illustration. Eff ects include Toon Shading, 

Stippling, Halftones and Edge Rendering. Buy the kit 

at thefoundry.co.uk/products/modo/kits/npr. 

The Multi-Eye ZTool
Developed by well-known CG artist 

Pablander, the Multi-Eye ZTool is a 

completely free ZBrush plugin that 

enables users to quickly and easily create diff erent 

eye types for characters and creatures. The RAR 

fi le on pablander.selz.com contains the ZTool as 

well as a quick guide to set up the tool and a 

reference video guide in HD.

V-Ray 3.2 for 3ds Max
Now compatible with 3ds Max 2016, 

Chaos Group’s latest V-Ray 3.2 adds 

VR rendering capabilities, two new 

VR cameras and multiple V-Ray RT GPU 

enhancements. The free update for 3.0 users will 

also include improved volume rendering, distributed 

rendering and global ilIumination algorithm 

improvements. Learn more at chaosgroup.com.

Full details on the challenge will be available on
ronenbekerman.com and unrealengine.com.
©GH House Interior by Bertrand Benoit

“Sharing info and building networks is what helps artists band 
together,” said Andre Luis, founder of THU. Learn more and 
buy tickets at trojan-unicorn.com

KeyShot 6 will be available for users this summer, with 
pre-existing KeyShot 5 customers getting a free upgrade. 
See a preview at keyshot.com/keyshot-6
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Exodus: Gods And Kings images
© 20th Century Fox

Description Audiomotion is a 
performance capture studio 
with 160 Vicon cameras and 
21,000 square foot of space. 
The team has delivered 
world-class animation for 
feature films, videogames, TV 
and commercials since 1997

Website audiomotion.com

Location England

Project Exodus: Gods And Kings 
(Equestrian motion capture for 
action sequences)

Client Double Negative, MPC, 
20th Century Fox

Software Vicon Blade, 
Audiomotion Live, 
MotionBuilder, Maya, Alice

Contributors Mick Morris (MD
of Audiomotion), Lindsay 
McFarlane (VFX coordinator 
on Exodus: Gods And Kings)

Portfolio Highlights

2013  World War Z

2008  The Chronicles Of Narnia: 
Prince Caspian

2006  Citroen Skater

2000  Robbie Williams’ Rock DJ

2000  Gladiator

 STUDIO ACCESS

01

05

The top mo-cap outfit shows off 
its horse capture skills with 
Exodus: Gods And Kings

Audiomotion 
Studios

H
aving worked with Ridley Scott on Gladiator way back in 

2000, Mick Morris says that working on the director’s 

latest project, Exodus: Gods And Kings, was like “coming 

full circle”. He goes on to explain that “the technology has 

moved on but the challenges become ever-greater. How do you 

create tens of thousands of convincing digital horses?”

Audiomotion was well placed to meet that challenge, as it has 

a strong history of equestrian motion capture, its first being a 

shoot in 2001 with only 14 cameras. The biggest challenge 

before Exodus was Prince Caspian, where there “was rarely 

more than one horse and rider in the capture volume at any one 

time”. For Exodus, Audiomotion had to be able to capture eight 

horses, harnessed into teams of two, hooked up to chariots and 

with two stunt performers on top. “Pretty daunting stuff,” Morris 

says, “since the challenge with any optical motion-capture 

system is creating a camera setup which can track the markers 

as accurately as possible.”

Having the horses hitched so closely together was a big part 

of the challenge. Morris explains: “The horses needed a specific 

suit design which we tailored for every animal. We then placed 

70 markers on each animal, 60 on each stunt performer and 40 

on the chariot, wheels and props. So approximately hundreds of 

markers, travelling at speed, through a very large volume. At 

times there were centimetre gaps between the animals.”

The solution, which Audiomotion engineered with the MPC 

team, was “to design and build a unique 150-camera system 

which could track this number of markers at relatively high 

speeds. A lot of work went into calculating the size of the 

volume including factoring the speed of travel of the fastest 

horses when attached to the chariots. Space is needed for 

acceleration from a standing start and of course slowing to a 

stop from maximum speed. Another key element to this plan 

working smoothly was in the design of the truss system from 

which we would hang the cameras.” This truss covered 13,000 

square foot, with the “capture volume covering a total area of 

4,300 square foot. This covered the turning circle for the teams 

moving at speed.”

Audiomotion shot with horses for a full week, and then did 

another week of “stunt and crowd work for both Double 

Negative and MPC’s crowd systems, whereby tens of 

thousands of digital extras were created. MPC built three 

armies; Hittites, Egyptian and Hebrew. As well as armies, the 

builds included Egyptian civilians, hero horses and digidoubles of 

Moses and Ramesses II.” Both companies used Audiomotion 

Live to make selections after the shoot, with capture and 

clean-up in Vicon Blade through MotionBuilder to Maya.

But filling the studios with stampeding horses isn’t all 

Audiomotion does. Morris recently went to the premiere of 

Pourquoi J’ai (Pas) Mangé Mon Père, the first full-length 

animated feature the company has worked on. Morris says it 

was “a lot of work over two months of shooting but the end 

result – the movie – is a lot of fun.”
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01  Serious space was needed so 
the horses could accelerate and 
decelerate safely

02  “Exodus was the second time of 
capturing equestrian motion 
with [Audiomotion] and we’d 
raised the stakes by asking to 
capture pairs of horses 
galloping side by side pulling 
chariots,” says VFX coordinator 
Lindsay McFarlane

03  Vicon Blade, Audiomotion Live, 
Motion Builder, Maya and Alice 
were all used in Exodus

 
04  Horse capture has become a 

speciality of Audiomotion’s, but 
previous projects were not on 
the same scale as Exodus

05  Audiomotion also worked on 
World War Z, which Mick 
Morris calls “great fun”

06  “From the first production 
meeting at Double Negative we 
knew this was going to be 
something very different,” said 
Mick Morris06

03 04

02

MickMorris,MDofAudiomotion

 Pretty daunting stuff, since the challenge 
with any optical motion capture system is

creating a camera setup which can track the 
markers as accurately as possible  



Images of the month
Theseare the3Dprojects thathavebeenawarded ‘Image
of theweek’on3DArtistOnline.com in the lastmonth

01

03

01Dragon
byGordeiKrasnov
3DAusername
Gordei
Gordeisays: “I always

wanted to come upwithmy own
dragon design. It’s a classic design,
so therewasn’tmuch room for big
changes or any painstakingwork on
the established rules.”
Wesay:Gordei’s image really leapt
out at us – it’s a brilliant rendition of a
typical dragon and looks pretty
fearsome. The big globules of saliva in
themouth add to the realism.

03Rainy Day
byVahidMontazeri
3DAusername
bbbb5331
Vahidsays: “Imodelled

the FordMustangGT500 and
rendered it in the rain. The
modellingwas completed in 3ds
Max and renderingwas done in
V-Ray. I hope that you like it!”
Wesay:Vahid has done a great job in
creating an atmosphere for his scene
while still paying considerable
attention to the crispness and
authenticity of his vehiclemodel.

04Villa In
England
byNguyenThanhVich
3DAusername
Vicnguyendesign

Vicsays: “Here is the project Villa in
England. It was a desertedmansion
and I was invited tomodify it. The
project gaveme great inspiration,
which I expressed in CGI.”
Wesay:We’ve seen a few houses just
like this here in theUK! This is a great
example of classical arch-vis, using
something traditional rather than
conceptual as inspiration.

02 Livingroom
byDanielReuterswärd
3DAusername
daniel.reutersward
Danielsays: “This is a

personal project createdwith 3ds
Max, Corona Renderer and
Photoshop. It started as inspiration
from stylist Hans Blomquist but
slowly changed tomy own design.”
Wesay:This is a great example of
interior arch-vis – superbmodelling,
texturing and composition. It’s our
image of themonth because of the
incredible lighting and reflections.
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Share your work, view others’ and chat to other artists, all on our website

Register with us today at www.3dartistonline.com



Tribute to a 
Wizard   
by Rafael John 
R Regidor
3DA username 

fl amedidea
Rafael says: “A tribute to 
Christopher Lee. It started as a 
daily speed sculpt, but I decided 
to push the details further and 
turn it into a fi nal piece.”
We say: We were extremely sad to 
hear of the passing of such a 
wonderful actor with such an 
illustrious fi lmography back in June. 
Rafael’s tribute is a fi tting one and 
an excellent bit of sculpting, too.

Hamburguesa by Omar Dujarick
3DA username Dujarick
Omar says: I created this with Maya, Arnold and Evermotion 
gallery models. Textures and maps have all been modifi ed. The 
postproduction work was done in After Eff ects and Photoshop.”

We say: We picked this when we were very hungry, for obvious reasons. Omar’s 
burger image looks absolutely delicious and is well textured, too.

Astrobot by Maipai Suppaudom
3DA username Krit Suppaudom
Krit says: I’m very excited every time I create robots and mechs. 
I’m interested in the detail, material and texture of this image. 
These things are really enjoyable for me .”

We say: This is the second time we’ve featured Krit recently, as his mech designs 
always stand out. We love the refl ectivity of the armour and the choice of colour 
works really well.

Le Morne by Terri Brown
3DA username BROWN T-POT
Terri says: “Fully made with CGI, this home in the shadow of the 
famous Le Morne Brabant mountain in Mauritius was designed 
by Eric Chavoix Architects to naturally blend into the landscape 

and provide exceptional views over the bay.”
We say: This image is serene and idyllic, and the composition is a particular 
highlight. Yet another excellent example of lighting and well-executed refl ections.

02

04
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Image
of the
month



YOUR FREE RESOURCES
Log in to filesilo.co.uk/3dartist and download your 3D resources NOW!

YOUR BONUS 
RESOURCES
ON FILESILO THIS ISSUE, FREE AND 
EXCLUSIVE FOR 3D ARTIST 
READERS, YOU’LL FIND OVER 8GB 
OF RESOURCES, INCLUDING…

experts at Digital-Tutors

25 3DTotal textures

Gaffer

THISMONTH’S
COMBINED
RESOURCESIZE: 8GB

SCULPTINGWORKFLOWSINBLENDER

EVERYTHING 
YOU NEED 

TO FOLLOW 
ALONG WITH THE
MAGAZINE AND
CREATE GREAT

3D ART

WORKFLOWSI

CGAxis 
models
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FILESILO–THEHOMEOFPRORESOURCES
A rapidly growing library 
Updated continually with cool resources
Lets you keep your downloads organised
Browse and access your content from anywhere
No more torn disc pages to ruin your magazines

No more broken discs
Print subscribers get all the content
Digital magazine owners get all the content too!
Each issue’s content is free with your magazine
Secure online access to your free resources

Discover your free online assets

The most popular downloads are shown 
in the carousel here, so check out what 
your fellow readers are enjoying

Green open padlocks show the issues 
you have accessed. Red closed padlocks 
show the ones you need to buy or unlock 

Find out more about our online stores, 
plus useful FAQs such as our cookie and 
privacy policies and contact details

If you’re looking for a particular type of 
content, like software or video tutorials, 
use the filters here to refine your search

Can’t find the resource you’re looking for 
in these filters? Click on More Types to 
specify what kind of resource you want

Top Downloads are listed here, so you 
can get an instant look at the most 
popular downloaded content

Check out the Highest Rated list to see 
the resources that other readers have 
voted for as the best

Discover our fantastic sister magazines 
and the wealth of content and 
information that they provide

The first time you use FileSilo, you’ll need 
to register. After that, you can use your 
email address and password to log in

This is the new FileSilo site that replaces 
your disc. You’ll find it by visiting the link 
on the following page
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HOW TO US
EVERYTHING YOU NEED TO KNOW ABOU
ACCESSING YOUR NEW DIGITAL REPOSITO

Having trouble with any of the techniques in this issue’s tutorials? Don’t know how to make the
best use of your free resources? Want to have your work critiqued by those in the know? Then
why not visit the 3D Artist Facebook page for all your questions, concerns and qualms? There is
a friendly community of fellow 3D artists to help you out, as well as regular posts and updates
from the magazine team. Like us today and start chatting!

facebook.com/3DArtistMagazine

NEEDHELPWITH
THETUTORIALS?

Issue84of  is on sale 12 August 2015 from GreatDigitalMags.com                      

ToaccessFileSilo,pleasevisit filesilo.co.uk/3dartist

01 Follow the on-screen 
instructions to create 

an account with our secure 
FileSilo system, and then log 
in and unlock the issue by 
answering a simple question 

about the 
magazine. You 
can access the 
content for free 
with each issue 
of 3D Artist.  

02 If you happen to be a 
print subscriber, you 

can easily unlock all the 
content by entering your 
unique Web ID. Your Web 
ID is the eight-digit 
alphanumeric code that is 
printed above your address 
details on the mailing label of 
your subscription copies. It 
can also be found on any 
renewal letters you receive. 

03 You can access 
FileSilo on any 

desktop, tablet or 
smartphone device using 
any popular browser (such 
as Safari, Firefox or Google 
Chrome). However, we 
recommend that you use a 
computer to download 
content, as you may not be 
able to download files to 
your phone or tablet.  

04 If you have any 
problems with 

accessing content on 
FileSilo, or with the 
registration process, take a 
look at the FAQs online or 
email filesilohelp@
imagine-publishing.co.uk.
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